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Welcome to DemoShield®



Frequently Asked Questions

This section is intended to provide users of DemoShield with answers to the questions most frequently 
asked.

AppCam FAQ

Common Questions

DemoNow Instructions

URL Resource Instructions

Windows 95/NT 4 Questions

Live Application Demos

Graphics

How...

Video



Sample Demos

This section discusses the techniques used to construct the Sample Demos included with DemoShield. 
Choose a topic from the list below.

CBT Demo

CD Browser Demo

CD Browser Template

Live Application Demo

Presales Demo

Product Demo

Quick Tour Demo

Helper Applications Used for Demos



Technical Notes

This section provides detailed technical information about DemoShield. Choose a topic from the list 
below.

How DemoShield Controls Applications

Send Message Action



Tips, Tricks, and Techniques

This section consists of Tips, Tricks, and Techniques that can be used to enhance your demos. Choose 
a topic from the list below.

AppCam Tips & Tricks

Capturing Images

Creating a Good Demo

Image Capture Tips

Improving the Performance of Your Demo

Launch Application Action

Making Your Demo Easy to Use

Previewing a Demo

Reducing the Size of Your Demo

ScreenCam Tips

Steps in Creating a Demo

Windowed Mode Demos



Read Me

This section contains the latest updates and information available just prior to the release of this 
software.

File Information

Getting Started

Known Problems

Recent Changes



Getting Started

DemoShield Tour

To learn the concepts involved in demo design and using DemoShield, it is highly recommended that 
new users view the DemoShield Tour.    This is a demo included with DemoShield that can be launched 
from the Welcome screen.    Simply click the Quick Tour button.

Tutorial

The Getting Started Guide explains how to use much of the main functionality of DemoShield.    Once 
you have completed the tutorial, you will know the basic steps for creating a demo.

Demo Wizard

DemoShield's all new Demo Wizard makes it easy to create top-notch demos and tutorials of your 
application. The Demo Wizard offers six different template demos to get you going: presales demo, 
quick tour demo, cue card tutorial, tutorial, CD browser, and press demo.    Just choose the type of 
demo youd like to create.

Sample Demos

Sample demos have been provided to give you examples of how to construct professional looking 
demos.    Simply click on the Program Item in the DemoShield group to launch one of these demos.    
Check out the Sample Demos section of the DemoShield Knowledge Base if you want to learn more 
about a particular demo.



Known Problems

1. ScreenCam Movie does not play:

Assuming that you have followed the steps covered in "ScreenCam Instructions" and your 
ScreenCam Movie (SCM) doesn't play, it may be possible that you have used an older version of 
the ScreenCam Player (SCPLAYER.EXE) on your system.    You must use version 2.1 of    
SCPLAYER.EXE with DemoShield.    Failure to do so will result in your SCM files not playing.    To 
determine what version of ScreenCam you are using, launch SCPLAYER.EXE.    If the splash 
screen displays a ScreenCam 96 logo, you are using the correct version.    Otherwise, you must 
install ScreenCam from the DemoShield CD and locate the correct SCPLAYER.EXE.

2. Designer will not save under Windows 95:

If you are using the Windows 3.1 version of DemoShield under Windows 95 and you have Norton 
Navigator for Windows 95 installed, you may be unable to save a demo.    This is caused by a 
feature in Norton Navigator referred to as Long Filename Enabler.    This feature attempts to 
provide legacy applications (i.e., Windows 3.1 applications) the ability to recognize and utilize 
long filenames (i.e., a filename that exceeds the DOS 8 character limit).    However, it is 
incompatible with DemoShield.    To save the demo, disable Long Filename Enabler via the 
Norton Navigator Control Center.

3. Designer unable to capture images:

You may be unable to use the Designer to perform screen captures if you are using the video 
drivers included with the ATI Mach 32 or Mach 64 video board.    If you are using an ATI video 
board, you will need to change the display driver you are using to VGA.    Consult the Windows 
documentation for information on configuring your computer.

4. AppCam does not support 256 colors:

When creating an AppCam sequence, DemoShield will not realize a color palette.    If your 
application uses nonstandard colors, it will not appear correctly. To avoid this problem, capture 
sequences at 16 colors when possible. 

5. Open, Save, and Save as dialogs take a long time to display:

DemoShield stores the last five directories that have been accessed.    When displaying an Open, 
Save, or Save as dialog, DemoShield attempts to query the drives that were last accessed.    If a 
path points to a drive that is currently invalid, the dialog will take significantly longer to display 
than it would otherwise.    For example, a demo located on a machine accessed via a network is 
opened.    Later, that machine is turned off (making the path to it no longer valid).    Any activity in 
the Designer that causes a Open, Save, or Save as dialog to be displayed would be met with a 
significant delay.    Opening five demos that are located in valid drives will resolve this problem, as 
all stored paths would then be valid.

6. When playing a demo with Go To Sub-Scene and Return From Scene actions in the 
Designer, DemoShield will not reset the Automation object's properties:

If an Automation object is used along with the Go to Sub-Scene action and the Return from 
Scene actions, the Automation object will only correctly refer to the Automation Resource on the 
initial playback.    Once the Return from Scene action is triggered, the Automation Object will not 
be reset and the Automation Resource will not be played.    To reset the Automation object 
manually, open and close the properties of the Automation object.



7. Unable to create Listbox Object or Automation Object

When creating an object in DemoShield, the object's default values are derived from the current 
template attached.    Older templates used with earlier versions of DemoShield may not contain 
any settings for the Listbox Object or the Automation Object.    To correct this problem, attach a 
newer template.    Do the following:

1. Select Attach Template from the File menu

2. Locate the TEMPLATES directory (the default location is "C:\IShield\DShield\TEMPLATE" 
under Windows 3.1 and "C:\Program Files\InstallShield\DemoShield\Template" under 
Windows 95/NT.

3. Attach any template included with your latest DemoShield installation

8. Unable to create Empty Scene

When creating a new Scene in DemoShield, the New Scene dialog derives the scene layouts 
from the    current Template attached.    Older templates provided with early versions of 
DemoShield did not include an empty scene.    It is suggested that you attach a newer template 
using the above steps.    Otherwise you may do the following:

1. Select Scene Sorter from the Scene menu

2. Click the New Scene button

9. VCR Object does not have Pause/Continue Button Caption

When creating an object in DemoShield, the object's default values are derived from the current 
template attached.    Older templates may not contain any caption for the Pause/Continue button. 
It is suggested that you attach a newer template using the above steps.    Otherwise you may do 
the following to add a caption:

1. Open the properties of a VCR Object

2. Select the Object Styles tab

3. Verify that there is a check next to Pause/Continue in the VCR Buttons listbox

4. Select Pause/Continue from the VCR Buttons listbox

5. Enter the desired caption in the Button Caption edit field (e.g., Pause/Continue)

10. Specified cursor fails to display when mouse is moved over a Hot Spot.

Display of a cursor using the Hot Spot object in a scene that is accessed via the Return from 
Scene action will display using the standard pointer instead of a custom cursor (i.e., Light Bulb, 
Question, Hand, Video, Sound, and Money) if you are using DemoShield version 5.00.005 or 
greater.    Earlier versions will generate a GPF in the DemoShield Player or Designer.

11. When attempting to install ScreenCam the following error is displayed:

Error Initializing the Copylist: 1

Developers: you need to have licenser section with CAMTOP in INI file

This error is caused by an incompatibility with devices running in DOS Compatibility Mode under 
Windows 95.    To install ScreenCam 96, copy INSTALL.EXE and its support files 
(DS32\SCM96\*.*) onto a device not using DOS Compatibility Mode.    To determine which 
devices are using DOS Compatibility Mode do the following:

1. Select Control Panel from the Start button on the Taskbar

2. Open the System Control Panel



3. Choose the Performance tab

4. Devices using DOS Compatibility Mode will be displayed here

12. When attempting to play ScreenCam Movie the following error is displayed:

Can't run 16-bit Windows program

Cannot find file DEMODIRNAME SCMDIRNAME (or one of its components).  Check to ensure the path 
and filename are correct and that all required libraries are available.

This error occurs under Windows NT if you attempt to install a demo into a directory using a long 
path name and your ScreenCam Movies have been Imported by Reference.    To resolve this 
problem, install into a short path name directory or convert the long path name into a short path 
name (e.g., "Program Files\Demo" -> "Progra~1\Demo").

13. AppCam display flashes as it is being played back.

When playing an AppCam using the Test Play feature in the Automation Viewer, the images are 
displayed in rough draft quality.    When the AppCam is previewed in the Design Window from 
within the Designer, it will appear as it would when the demo is played using the DemoShield 
Player.

14. Hide/Show and Enable/Disable actions set for a specific duration fail to perform properly.

The Hide/Show and Enable/Disable actions require that Time Events be sent to objects when a 
specific duration for the action is designated.    When the Pause on Scene transition is utilized, 
Time Events are no longer distributed to objects in the scene when the scene duration has be 
equaled.    To avoid this problem, increase the duration of the scene or do not use the Pause on 
Scene transition.

15. Move Object actions do not effect event distribution.

Move Object actions such as Move Object to Front, Move Object Back, etc., do not effect the 
distribution of events to the objects.    Therefore, an object moved behind another object will still 
receive an event (such as a mouse click) before the object it is in front of. 



Recent Changes

This section will contain information about changes as they are implemented.



How DemoShield Controls Applications

Summary

DemoShield has the concept of an Application Object which provides a mechanism for launching and 
controlling other applications. The size and position of the application are set immediately, from values 
defined in the Application Object properties, after the application launches. User interaction with the 
running application is controlled through hook functions which can discard messages not produced by 
DemoShield. The application is terminated by simulating the process that occurs when the user selects 
close from the system menu.

Additional Information

The DemoShield Application Object launches an application through the following process:

1. The Application Object uses the "WinExec API" under Windows 3.1 or the "CreateProcess" API 
under Windows 95/NT to launch the application.

2. The Application Object waits for the application to boot up.

3. If a Windows caption and/or Windows class name is defined under the Options tab of the 
Application Object properties, then the "FindWindow" API is used to locate the main window of 
the application.    Otherwise the "EnumWindows" API is used to enumerate all top level windows 
until a window is found associated with the executable of the application.

4. The Application Object then positions and sizes the main window of the application as specified in 
the Application Object properties dialog box. 

5. If the Application Object disables user interaction with the application, then the Application Object 
installs a mouse and keyboard hook function to filter out messages intended for the application 
from the mouse or keyboard.

When DemoShield needs to terminate the application, the main application window controlled by the 
Application Object is sent a system command message, SC_CLOSE, to simulate the user selecting 
close from the system menu of the application.



Metafile (WMF) Fails to Display Properly

What does DemoShield Expect?

DemoShield relies upon data contained within an Aldus placeable header to determine how best to 
best display a metafile.    Consult the user's guide of the graphics software you are using for information 
on how to save graphics files as a Windows metafile with a placeable header.

Potential Problem

n Metafile is displayed but does not scale.

n Metafile fails to display.

Solution

n Use a clip art library containing placeable metafiles.

n Use a graphics application that supports placeable headers to create and/or convert your 
metafiles.



Overview

For information on using the DemoShield Knowledge Base, choose a topic from the list below.

Introduction

Masthead

Note from the Editor

Using this Guide

Button Bar

Menu

Contents

Read Me

Frequently Asked Questions 

Sample Demos

Technical Notes

Tips, Tricks, and Techniques

Technical Support



MastHead

DemoShield Knowledge Base

Build Date February 7, 1997

Copyright 1997 by DemoShield Corporation

DemoShield is a registered trademark of DemoShield Corporation.    Other brand and product names 
are trademarks or registered trademarks of their respective holders.    Microsoft is a registered 
trademark and Windows, Windows NT, the Windows logo and the Windows NT logo are trademarks of 
Microsoft Corporation.

Disclaimer

Information in this document is subject to change without notice and does not represent a commitment 
on the part of DemoShield Corporation.    The software described in this document is furnished under a 
license agreement.    The software may be used only in accordance with the terms of the agreement.    
It is unlawful to copy the software on any medium except as specifically allowed in the license or 
nondisclosure agreement.    The purchaser may make one copy of the software for backup purposes.    
No part of this document may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, for any purpose other than the personal use of the purchaser, without the express written 
permission of DemoShield Corporation.



Note from the Editor

February 7, 1997

Dear DemoShield User:

The purpose of the DemoShield Knowledge Base is convey up to date, accurate information about the 
current version of DemoShield and to facilitate the development of demos by our users.    When in 
doubt of how to proceed consider the Knowledge Base your first option.

Many of the articles were created as a result of my own experiences with DemoShield.    I hoped that by 
writing what I have learned, I could help all levels of users get the most out of DemoShield.    I welcome 
your questions and feedback on the Knowledge Base, DemoShield, product documentation, the 
technical support services we provide, or any related topic.    If you need more information on any topic 
in this document, would like to see other topics included, or would like to submit an article for 
consideration in the Knowledge Base please contact me at cuauhtemoc@demoshield.com or FAX 
(847) 240-9138.

Thank you for using DemoShield and the Knowledge Base.

Sincerely,

Cuauhtemoc B. Chamorro
Knowledge Base Editor



Menu

The Menu offers the following items:

File menu item allows you to open another help file, print any topic, or to setup the printer.

Edit menu item provides you with an option to Copy or Annotate.

View menu item provides you with an option to view Contents Only, Contents and Topic, Topic 
Only, History or Switch Panes (between contents and topic).

Bookmark menu item lets you define a bookmark for a particular topic.

Help menu has information about the viewer.



Button Bar

The button bar makes navigating through information a breeze.    It provides shortcuts for finding, 
marking, copying, and printing topics and subtopics.    Following is a description of the button functions. 
Shortcut keystrokes appear when the cursor covers a button.    They are also listed below.

{ewl MVBMP2, ViewerBmp2, bmps.bmp}

View Contents Only    Select this option, if you only want to view the Contents or tree list.    By doing 
so, you will only have the contents window in view.    Detailed topic information will not be available.    
Shortcut Keys: Ctrl+Shift+C

View Topic and Contents    This will display both the content window    and the topic window.    This is the 
default setup.    Shortcut Keys: Ctrl+Shift+S

View Topic Only    This displays only the topic window; the content window is not visible.    The Search 
Combo Box, however, can be used to find a particular topic.    Shortcut Keys: Ctrl+Shift+T

Full Text Search    Use this to perform a full text search in the help file.    The search is not restricted to 
the key words or function names.    Any text or combination of text can be searched (more than one word). 
All the topics containing the search word(s) are displayed in a dialog box.    Any of those topics can be 
displayed by highlighting it and then double clicking it or using Go To button.    Shortcut Keys: Ctrl+F

Go to the Previous Content    This will take you to the previous content in the tree list.    Shortcut Keys: 
Ctrl+<
Note    This takes you back to the previous CONTENT, not the previous screen.    To go to a topic viewed 

previously, use  button to bring up history list and select the desired topic.

Go to Next in Content    This takes you to the next content in the tree list.    Shortcut Keys: Ctrl+>

Copy from the current topic    This opens up a dialog box, where you can select the part of the current 
topic you want to copy.    Highlighting the part and selecting Copy button will copy the contents to the 
clipboard.    Shortcut Keys: Ctrl+C

Print the Current Contents    This prints current topic to the default printer.    Shortcut Keys: Ctrl+P

Synchronize the Current Content with the Topic This will synchronize the current topic with the content 



in the tree list.    By selecting this button, the content corresponds to the topic highlighted in the tree list.    
Shortcut Keys: Ctrl +Y

Bring Up the History List    Use this list to jump to any previously viewed topics.    Shortcut Keys: 
Ctrl+Shift+H

Bring Up the Bookmark List    Any bookmark set previously using the Bookmark menu appears here.    
Shortcut Keys: Ctrl+ Shift+B

Display the Viewer Related Help This opens another viewer window and displays more information 
about the viewer.    Shortcut Key: F1

Search any Topic Search for any topic by typing the first few letters of the topic name.







Technical Support

DemoShield Corporation welcomes your technical support questions and comments.    Please follow 
the procedures outlined in this topic carefully to ensure the most efficient technical support response.

Introduction

DemoShield Support Programs

Lotus Technical Support

Resources

Procedures

Before You Call...

Requesting Help

CompuServe

Calling For Support

Addresses and Phone Numbers

Domestic and International Sales



Addresses and Phone Numbers

Sales and Marketing

Internet: info@demoshield.com

Fax: Corporate Office (847) 240-9120

Phone: Corporate Office (847) 240-9111
Sales (800) 250-2191

Mail: DemoShield Corporation
900 National Parkway Suite 125
Schaumburg, IL 60173-5108
USA

World Wide Web: http://www.demoshield.com

Technical Support

Internet: support@demoshield.com

ftp: ftp.demoshield.com 1) log in as "anonymous"
2) enter your e-mail address as the password, 
3) read "readme.txt" if you are a first time user

Fax: (847) 619-8507

Phone: (847) 240-9135

CompuServe: DemoShield Forum: GO WINAPC

CIS ID: 74774,552

World Wide Web: http://www.demoshield.com



Procedures

DemoShield Corporation offers several methods of obtaining technical support.    Certain methods are 
preferred over others because they are more efficient.    Follow the technical support procedures to 
ensure that you receive the best technical support.

Benefits of Following Technical Support Procedures

Following the proper technical support procedures rewards you with several benefits:

n You get the fastest service

n You get the most complete response

n You get the most accurate response

n You get the correct response the first time

n You get improved service in the future

Not following technical support procedures hampers the process of gathering and processing 
information.    The result is that problems, questions, and requests cannot be addressed efficiently.

Technical Support Procedures Illustration

The following illustration shows the correct procedures to follow for technical support.    Following the 
procedures will save you time and effort by directing you to the best sources of information in the most 
effective order.



  



Technical Support Procedures Illustration.



Resources

There are many technical support resources available to registered users:

n Your DemoShield Documentation

n Sample Demos

n DemoShield Knowledge Base

n Maintenance Releases

n DemoShield Home Page (www.demoshield.com) and CompuServe

DemoShield Documentation

The DemoShield Knowledge Base and User's Guide have grown out of years of experience with 
thousands of customers.    DemoShield Corporation tries to provide the information and answers you 
need to get the most out of DemoShield.    Your DemoShield documentation is the first place to look for 
answers.

Sample Demos

Several sample demos are installed on your hard disk along with DemoShield.    The sample demos are 
a great source of techniques and tips for making successful demos.    If you have a question or 
problem, there is a good chance you will find useful information in one of the sample demos.    Several 
of the sample demos have an accompanying article written as part of the DemoShield Knowledge Base 
discussing the techniques used I their creation.    See the Sample Demos book.

DemoShield Knowledge Base

You are currently viewing the DemoShield Knowledge Base.    Since it is primarily a direct result of 
questions posed by users, the Knowledge Base will likely contain the answers you need to get your 
demo working now.    Updates to the DemoShield Knowledge Base are posted on CompuServe and the 
DemoShield Home Page regularly.

Maintenance Releases

DemoShield Corporation is committed to providing the best solutions possible for our customers, so we 
make maintenance releases of DemoShield available regularly.    Maintenance releases make minor 
changes and improvements to the product and include documentation describing those changes and 
improvements. DemoShield Corporation recommends that you periodically download the maintenance 
releases to see what has changed and improved.    Maintenance releases are posted on the 
DemoShield Home Pageand CompuServe about every two months or as required.

Receiving Maintenance Releases

DemoShield Corporation regularly makes maintenance releases available on the Internet 
andCompuServe for registered users.    Maintenance release files are password protected.    You can 
request the password by sending a message to the DemoShield Technical Support department on the 
Internet, CompuServe, or FAX.

Note    When requesting a maintenance release password, include your full registered name, address, 
phone and FAX numbers, the serial number of your copy of DemoShield, and the version numbers of 
all of its components. DemoShield Corporation cannot issue the password without this information.    
Refer to the Know Your Version Numbers section in Before You Call...

Only the affected components are upgraded in a maintenance release.    You can replace existing 
components with maintenance release upgrades.

For example, if you have DESIGNER.EXE version 5.00.000 and you wish to upgrade to version 



5.01.005 would replace DESIGNER.EXE, DEMO.EXE, and DS.DLL to assure consistency between the 
Designer and the Player.    Refer to the Know Your Version Numbers section in Before You Call... for 
information on version numbers.

It is your responsibility to replace outdated components with maintenance releases.    Most 
maintenance releases contain a README file with valuable information to help you upgrade 
successfully.

DemoShield Home Page and CompuServe

Hint    The best way to send a request for technical support to DemoShield Corporation is through 
CompuServe or the Internet.    Refer to the CompuServe section for information on accessing the 
DemoShield Forum.    Internet information can be found in Addresses and Phone Numbers.

A good place to look for information related to your problem or question is on-line--on CompuServe or 
the DemoShield Home Page.    Each year thousands of users exchange information through the 
DemoShield forum and DemoShield Home Page.    DemoShield Corporation strongly recommends that 
you visit the forums and explore the questions and dialogs between customers and DemoShield 
Technical Support representatives.    You will find answers, suggestions, tips, and techniques that will 
save you time and effort.



Before You Call...

Are You a Registered User?

You must be a registered user to receive technical support.

To register, fill out and send in the software registration card that is included with your copy of 
DemoShield.    Include your name, address, company name, phone and FAX numbers, and any 
electronic mail or BBS numbers.    The registered user must be the person using the software and 
calling for technical support not the software librarian of the company.

If you have not registered and need technical support, fill out and FAX your registration card to the 
DemoShield Technical Support department at the number listed in the Addresses and Phone Numbers  
table.    Since all technical support requests are tracked by registered user name, you must be a 
registered user in order to get technical support.

Have You Enrolled In a Support Program?

DemoShield offers a support plan to meet your needs, whether you are an individual developer or a 
company. DemoShield has made 60 days of free technical support available to the customer with the 
purchase or upgrade of existing DemoShield products. The 60-day period begins on the first day of 
contact with DemoShield Technical Support. After the 60-day offer expires, you may choose between 
the Standard or Priority Programs to best suit you support needs in the future.    For additional 
information on Support Programs see the DemoShield Support Programs topic.

Know Your Version Numbers

DemoShield version numbers are critical information that the Technical Support department needs to 
answer questions and correct problems related to an installation.    Version numbers tell exactly which 
versions of the DemoShield components you have.    When requesting technical support, always be 
prepared to give the complete version numbers of DemoShield and its components.

DemoShield product version numbers have the following format:

DemoShield Version Number Breakdown.

For example, 5.01.001 is major release version 5, minor release version 01, and maintenance release 
version 001.

Major Release

A major release represents the most significant update of DemoShield--a new generation of the 
product.    Major releases are generally made available on a 12- to 16-month cycle.    All registered 
users are notified of major releases.    Major releases are on a per fee basis.

Minor Release

A minor release signifies major enhancements to an existing major release. Minor releases are 



generally made available on a 4 month cycle.    All registered users are notified of minor releases.    
Minor releases are on a per fee basis.

Maintenance Release

A maintenance release solves minor problems--usually small changes to the product that generally do 
not affect overall functionality or usage, but correct incompatibilities with various environments or deal 
with obscure bugs.

Maintenance releases are generated on an as-needed basis or approximately every other month.    
They are made available on the Internet and    CompuServe as compressed files free of charge to all 
registered users.    Maintenance releases are not announced.

DemoShield Subscription Service Plan

In order to meet your upgrade needs, DemoShield offers a service that guarantees access to the latest 
releases of DemoShield products. Rather than ordering separately, this option provides that upgrades 
will automatically be sent which ensures that you always have the latest demo creation technology 
working for you.

As of February 1, 1997, all registered users of DemoShield will be given the option to purchase an 
annual subscription service plan, which includes the following:

n Annual subscription cost is $175 per year.

n All upgrades to incremental and major product releases for one full year.

n A minimum of two incremental releases guaranteed annually.

n Addenda to documentation provided electronically.

n Subscription Service Plan available for domestic customers only.

n Printed documentation for major releases available at an additional charge.

Finding Your Version Numbers

Run the Designer.    Select About under the Help menu.

Use the Resources On Hand

As shown in the Procedures section, the first few steps in answering a question or solving a problem 
require information gathering.    The resources, described in detail in the Resources section, are listed 
again below:

n Your DemoShield documentation

n Sample demos included with DemoShield

n DemoShield Knowledge Base

n Maintenance Releases

n DemoShield Home Page and CompuServe forums



Requesting Help

When you are unable to resolve a problem on your own using the various resources on hand (see the 
Use the Resources On Hand section), it is time to request technical support.    For information about 
Support Programs see the DemoShield Support Programs topic.

Hint    The best way to request technical support is to provide detailed information about the problem 
you are experiencing and, if applicable, a sample demo to DemoShield Corporation via the Internet or 
CompuServe.    Picking up the phone and calling the Technical Support department or faxing requests 
that do not contain all of the required information are the least recommended methods of requesting 
technical support.

Before You Create a Request for Technical Support

Before you create a request for technical support, be prepared to give a variety of detailed information. 
Use the following lists to prepare the information.    It will save you time and effort.    Be prepared to 
provide:

System Information

n The make and model of your machine and video driver.

n Operating system you are using.

n The amount of memory and available system resources on your machine.

n Any other devices and peripherals in your system, if appropriate.

User and Version Information

n Your DemoShield serial number.

n Your full name and the name of the registered user, if different.

n Your address, including city, state/province, zip/postal code, and country (if outside the United 
States).

n Your company name.

n Your phone and FAX number.

n Your DemoShield version numbers (refer to the Know Your Version Numbers section
in Before You Call....

n Your operating system and version numbers (MS-DOS and Windows, Windows NT, etc.).

Information About the Problem

It is critically important for DemoShield Technical Support representatives to know exactly what you do 
when errors occur.    Most problems are resolved immediately once DemoShield Technical Support 
representatives get this sort of detailed information from you.

When describing the problem in a request for technical support, please use the following guidelines to 
make a thoroughly detailed description:

n As precisely as you can, give the exact details about the problem(s) or error(s) you are 
experiencing.

n List any error messages exactly as they appear on your screen.

n Provide a detailed list of the steps and conditions that DemoShield Technical Support 
representatives must follow to recreate the problem.

n If a problem is intermittent, please describe the machine and conditions existing just before it 



occurred.

Attachments

Attachment files may accompany a request for technical support.    Be prepared to include the following 
attachments:

A sample demo (Please ensure that the sample demo contains resources that causes the problem.    
Run the sample demo on different machines, note the results, and include information about the 
machines it is run on, such as Operating System, CPU type, RAM, etc.).

n Copies of your CONFIG.SYS and AUTOEXEC.BAT files, if appropriate.

n An MSD report (see the "Using Microsoft's MSD.EXE" section in this section).

Using Microsoft's MSD.EXE

Microsoft includes a program called Microsoft Diagnostics (MSD.EXE) as part of the Windows 3.x 
package.    MSD.EXE captures detailed information on your system and outputs the information to a 
file.    You can then upload the resulting .MSD file to the Technical Support department.

Note    Under Windows NT, the Microsoft Diagnostics program is named WINMSD.EXE.

Note    If your problem includes specific hardware-related issues, the technical support department 
must have the MSD report to help you.

To run MSD.EXE from File Manager or Program Manager:

1. Go to the system prompt

2. Type MSD

To run MSD.EXE under Windows 95:

1. Select Run from the Start menu

2. Type MSD

You can also run MSD.EXE at the C> prompt in DOS.

First you see the following screen:

{ewc MVBMP2, ViewerBmp2, [caption=";bMicrosoft Diagnostics Opening Screen"]bmps.bmp}

Choose Print Report from the File menu.    You will then see the following screen:

{ewc MVBMP2, ViewerBmp2, [caption=";bMicrosoft Diagnostics Print Report Screen"]bmps.bmp}

Use the tab key on the above screen to choose the information you want.    To OK the screen when you 
are done, press Enter.    You will see the Customer Information form.

Enter all the requested information into the Customer Information form, shown below:

{ewc MVBMP2, ViewerBmp2, [caption=";bMicrosoft Diagnostics Customer Information Screen "]bmps.bmp}

Running MSD.EXE and including the file in your request for technical support will help ensure that you 
get a fast response to your request for technical support.



CompuServe

CompuServe is one of the best methods of exchanging information with other DemoShield 
users and of sending your request for technical support to DemoShield Corporation.    It is 
available to you 24 hours a day, seven days a week.    The DemoShield Forum is updated twice a day, 
five days a week.

There are three ways to reach DemoShield Corporation on the DemoShield Forum:

1. DemoShield message section.

2. DemoShield e-mail (upload files only).

3. DemoShield file library (download files only).

The figure below shows the various parts of the DemoShield Forum.

Breakdown of the DemoShield CompuServe Forum.

Hint    Contact CompuServe for specific information on how to accomplish the various tasks in the 
CompuServe environment.    Look at the Addresses and Phone Numbers  table for important telephone 
numbers and electronic address information.

DemoShield Forum

The DemoShield Forum, located in the CompuServe Windows 3rd Party C forum, contains the 



DemoShield message section, DemoShield e-mail, and the DemoShield file library.

You can visit the DemoShield Forum by typing or executing GO WINAPC.    Once you are connected 
with the DemoShield Forum, you can:

n Read and post messages in the DemoShield message section.

n Upload files to and request technical support by DemoShield's e-mail address.

n Download files from the DemoShield file library.

Reading and Posting Messages in the DemoShield Message Section

The DemoShield message section gives you access to valuable information in the form of messages 
posted by other DemoShield users and the replies to those messages by other users and 
DemoShield's Technical Support department.    Feel free to post your own messages and reply to 
others.

Note    When posting a message in the DemoShield message section, always include DemoShield's 
CompuServe ID in the To: field, even if you post the message to ALL to ensure that DemoShield 
Technical Support is notified of your message immediately.    If you do not include the ID, notification 
may be delayed.    The DemoShield CompuServe ID is listed in the Addresses and Phone Numbers 
table.

When posting a message, please include your full name, company name and CompuServe ID in the 
body of the message so that DemoShield Technical Support can respond to the message quickly and 
efficiently.

Uploading Files to DemoShield's E-Mail Address

Uploading files is done as part of a request for technical support.    Refer to the Requesting Help 
section for information on how to prepare a request for technical support.    Use DemoShield's e-mail 
address, (listed in the Addresses and Phone Numbers table, to upload all requests for technical support 
and any accompanying files.

Please use PKZIP to compress files prior to uploading.

With all e-mail messages, please include your full name, company name and CompuServe ID in the 
body of the message so that DemoShield Technical Support representatives can respond to the 
message quickly and efficiently.

Downloading Files from the DemoShield File Library

You can download maintenance releases, sample demos, articles on topics related to DemoShield, and 
other useful information from the DemoShield file library.

How you download a file depends on the software you are using as an interface to CompuServe.    For 
the specific steps to follow to access the DemoShield file library and download or upload files, consult 
your software documentation or contact CompuServe.

Maintenance release files are password protected.    You can request the password by sending a 
message to the DemoShield Technical Support department on the Internet CompuServe, or FAX.

Note    When requesting a maintenance release password, include your full registered name, address, 
phone and FAX numbers, the serial number of your copy of DemoShield, and the version number of 
the Designer.    DemoShield Technical Support cannot issue the password without this information.

Be prepared to decompress downloaded files using PKZIP.



Faxing Information

If you cannot use the Internet orCompuServe to send your request for technical support, you can fax it 
to us.    Please read the Requesting Help section before faxing us your request for technical support.    
The information in that section will help you get the best response possible.    When you fax, please 
include your name, address, phone number, and FAX number.    The information must match the 
information on your registration card.    Incorrect and incomplete information will slow the process of 
providing you with technical support.

Mailing Information

If you cannot use the Internet, CompuServe, or FAX to send your request for technical support, you can 
mail it to us.    Please read the Requesting Help section before mailing us your request for technical 
support.    The information in that section will help you get the best response possible.

Use the address listed in the Addresses and Phone Numbers Addresses and Phone Numbers table to 
send disks or other information by mail or overnight express.    If you want your materials returned to 
you, please include a postage-paid mailer or FedEx air bill.



Calling the Technical Support Department

The Technical Support department likes to provide detailed and accurate answers to all your questions 
about DemoShield demos.    Please provide detailed information about the problem you are 
experiencing, and send your support request by the Internet, CompuServe, FAX--instead of 
calling the Technical Support department.    Using the Internet orCompuServe will allow the 
Technical Support representatives to investigate your questions in detail and have them answered by 
experts.

Note    Except in rare emergencies, picking up the phone and calling the Technical Support department 
is the least effective method of getting technical support.

Here are some of the reasons why calling the Technical Support department is the least effective 
method of getting technical support:

n Required information must be gathered during the phone call.

n Required information must be communicated verbally.

n Problem descriptions usually have not been adequately prepared.

n Technical Support Representatives do not have the chance to analyze what is often a complex 
set of interdependencies.

n A sample demo exhibiting the undesired behavior is not available for DemoShield Technical 
Support to evaluate.

Hint        Picking up the phone and calling the Technical Support department or faxing requests that lack 
all of the required information are the least recommended methods of requesting technical support.

If you must call, please have the following information ready before you call:

n DemoShield serial number.

n DemoShield version number (Refer to the Knowing Your Version Numbers section
in Before You Call....

n Your name and registered user's name (if different), and company name.

n Have the DemoShield documentation nearby.

n Ensure that the DemoShield program group is visible and that you are located at your computer.

You can contact the Technical Support department by calling the number listed in the Addresses and 
Phone Numbers  table.    DemoShield Technical Support representatives will do their best to help you 
when you call.    Be aware, however, that many problems are difficult to resolve completely over the 
phone, and gathering the required information is often slow and difficult. .    For information about 
Support Programs see the DemoShield Support Programs topic.



Introduction

DemoShield Corporation is committed to providing you with the finest technical support available.    
Please read this document carefully; it includes important procedures and information to 
ensure the best possible technical support. 

The Technical Support Department maintains an extensive database of registered users.    Each time 
you contact the Technical Support Department, your problem is entered into a database that 
DemoShield Corporation uses to document problems and solutions.    Technical support is 
available only to registered users. .    For information about Support Programs see the DemoShield 
Support Programs topic.

International Support

DemoShield Corporation provides technical support to registered users worldwide.    If you live 
outside the United States and need technical support, please contact the nearest distributor from the 
International Sales and Support list.    You can also contact the DemoShield Technical Support 
Department.

The Internet and CompuServe are the best way to contact technical support internationally.    If you do 
not have a CompuServe account or an Internet service provider, it is highly recommended that you get 
one.    You can access current information and files as well as receive the latest maintenance releases 
through CompuServe or the Internet.

When you request technical support, please include: your complete name and address, with city, 
state/province, and country (if outside the United States).    Also include your phone and FAX numbers, 
and dialing information from the United States.

Sales and Support



Domestic and International Sales

DemoShield is available worldwide through the network of authorized DemoShield Distributors listed 
below.    Contact the nearest distributor for both DemoShield sales and technical support.    You may 
also contact DemoShield Corporation for DemoShield support worldwide.

NORTH AMERICA

United States

DemoShield Corporation
900 National Parkway, Suite 108
Schaumburg, IL 60173-5108
Tel. : Sales and Marketing (800) 250-2191

Technical Support (847) 240-9135
Fax    (847) 240-9138
E-mail: Sales and Marketing info@demoshield.com

Technical Support support@demoshield.com

Argentina

SOTEICA S.R.L.

Av. Alvarez Thomas 796,3 C

(1427) Buenos Aires

Tel 54 (1)551-4981

Fax 54 (1)551-0751

E-Mail guido@soteica.com.ar

Australia

Microway Pty Ltd

Unit 1/16 Tarnard Drive

Braeside, Victoria 

Australia 3195

Tel 61-3-9580-1333

Fax 61-3-9580-8995

Fastfax 61-3-9580-4991

E-Mail 100231.1433@compuserve.com

Austria 

Milestone Software Austria



Kremsweg 12 

A-4531 Kematen/Krems

Austria

Tel [43](0)7228-6000 

Fax [43](0)7228-6100 

E-Mail 100231.1433@compuserve.com

Brazil

Multidoc Informatica e Documentacao

Rua Sacramento 126 -conj. 121

3010-911 Campinas SP

Brazil 

Tel 55-192-33-6123 

Fax 55-192-55-8057

Email multidoc@aleph.com.br

Canada

Developer's Workshop

95 Trinity Street, Suite 201

Toronto, Ontario

M5A 3C7 

Canada

Tel (416)363-8995 

Fax (416)363-4718 

Czech Republic

Unicorn Group SPOL S.R.O.

Domazlicka 13

Praha 3, 130 89

Czech Republic

Tel. 42 (2) 61 64 25 

Fax 42(2)61 21 64 25

Email unicorn@vol.cz



Denmark

Ravenholm Computing

Transformervej 9B 

DK-2730 Herlev 

Denmark 

Tel [45](44)889966 

Fax [45](44)889944 

Finland

Ravenholm Computing 

Kutomotie 9 C 

PL 21 

FIN-00381 Helsinki 

Finland 

Tel [358](0)506-2600 

Fax [358](0)506-2800 

Email jari.tuhkanen@SEC.fi

Software Engineering Center

H & P Software Engineering Center OY

Piispanportti 5, 02240 ESPOO 

Finland

PL 02241 ESPO Finland 

Tel 358-0-80451328 

Fax 358-0-80451333

WWW http://www.sec.fi

France

OSER/SOS DEVELOPPEURS 

2 Rue de Colonnes

75002 Paris, France 

Tel 33 (1) 42-441-122 

Fax 33 (1) 42-441-131 

Email sosdev@worldnet.net



Germany

ComFood

AM Rohrbusch 79

48161 Munster

Tel 49 2534/6213-0

Fax 49 2534/8852

Email info@comfood.com 

dc soft GmbH

Machtlfinger StraBe 21

81379 Munchen

Tel 49(89) 7858 910

Fax 49(89) 7858 9111

Email 72662.211@compuserve.com

Ing.Buro Voller 

NeutorstraBe 16 

89073 ULM Germany 

Tel 49-731-60784 

Fax 49-731-61508 

Email 100142.3411@compuserve.com 

Kessler Software

Schlesierring #2

Goettingen 37085

Germany

Tel 49-551-507620 

Fax 49-551-5076222 

Email 100337.36@compuserve.com

MicroBasic GmbH

Am Sommerfeld 11

D-85622 WeiBenfeld

Germany

Tel 49-89-90499049 



Fax 49-89-90499090

Email 102404.3646@compuserve.com

WWW http://www.microbasic.com/to49386.htm

Precision Software GmbH

Robert-Bosch Str. 5

#C 63303 Dreieich

Tel 49(6103)59340

Fax 49(6103)36955

Email chris@precision.de

WWW http://www.precision.de/installshield_co/installshield/is_deu.htm

SOS Software Service GmbH 

Alter Postweg 101 

8900 Augsburg Germany 

Tel 49-8-21-25782-0 

Fax 49-8-21-25782-50 

Mobile 49-1-61-1832523

Email jsantos@SOS 

Greece

UniTech International

16 Arkadias Street 

115 26 Athens 

Greece 

Tel [30](1)74 88881 

Fax [30](1)74 88882 

Iceland

Tolvur hf 

Armula 3 

128 Reykjavik 

Iceland 

Tel [354](1)605263 

Fax [354](1)605101 



Email Tolvur@skima.is

Ireland

Madec

23 Hanover Street

Cork

Tel 353(21)274055

Fax 353(21)272611

Email 73621.3626@compuserve.com

Israel

Kalanit

16 Homa Umigdal St. 

Tel Aviv 67771

Israel

Tel 972(363)86305 

Fax 972(35)372928 

Sun Electronics 

2 Kauman Sman Street 

Tel Aviv 68012

Israel 

Tel [972](3)5104311

Fax [972](3)5104313 

Email sunelect@netvision.net.il

Italy

AvaloN SAS

Corso Francia 222 

10093 Collegno (TO)

France

Tel 39(11)405-0100

Fax 39(11)405-1400

Email avalon@mbox.vol.it 



Silicon Valley On-line

22 Via Vicenza

35138 PADOVA 

Italy 

Tel. [39](49)8713444

Fax [39](49)8713055 

Email info@silicon.it

WWW http://www.silicon.it

Japan

Netserve, Inc.

1-8-1 Shibuya

Shibuya-Ku

Tokyo, 150 JAPAN

Tel. 03-3498-1828 

Fax. 03-3498-4040 

Email smorita@netserve.co.jp 

WWW http://www.skynet.co.jp/netserve

Netherlands

AIMED Solutions

Kaap Hoorndreef 34c

NL 3563 AT Utrecht

The Netherlands

Tel 31(0)30-2613559

Fax 31(0)30-2614820

Email ton@regioweb.nl

WWW http://www.regioweb.nl/bedrijf/installshield/index.htm

Delado bv

PO Box 162 3730 AD

De Bilt

Tel 31 (3027)36477

Fax 31 (3027)36482



Email delado@auronet.nl 

Professional Development Systems B.V. 

Zwarteweg 8

1412 GD Naarden The Netherlands

Tel 31-3569-48883 

Fax 31-3569-41712 

Email pds@inter.NL.net 

New Zealand

Milford Software Limited 

PO Box 31087

Milford, Auckland New Zealand

Tel 64-94-10-2800 

Fax 64-94-10-3613 

Email 10024.2342@compuserve.com or 100244.2342@compuserve.com

Norway

Polysoft

Rosenkrantzgt 95 Box 829 

N-3007 Drammen Norway

Tel 47(32)892240

Fax 47(32)895900

Email polysoft@polysoft.no 

Ravenholm Computing

Postboks 9868m ILA 

N-0132 Oslo 

Norway

Tel 47-2-211-0950

Fax 011-47-2-211-1220 

Software Innovation

Drammensvein 175

PO Box 390



Skoyen 0212 Oslo

Tel. [47](22)490030

Fax [47](22)490560 

South Africa

Graduator Support Services 

142 Hans Strydom Ave. 

Lyllelton Manor EXT-1

Gauteng

P.O. Box 7537-Hennopsmeer-0045

Tel 27 (12)664-5303

Fax 27 (12)664-5316

Email consulty@iafrica.com

Spain

Danysoft Internacional

Paseo de Albacete, 73

28700 San Sebastian de los Reyes

Madrid, Spain 

Tel. [34](1)6546298 

Fax [34](1)6546382 

Email danysoft@stnet.es

Sweden

LinSoft

SIT Larsgatan 9D 

Box 634

S 582 24 Linkoping

Sweden 

Tel. 46-13-11-1588

Fax: 46-13-15-2429 

Email 100112.273@compuserve.com

Switzerland



bbi Software GmbH

Alpenstrasse 48 

CH-4515 Oberdorf

Switzerland 

Tel. [41](65)271661 

Fax [41](65)271668 

Email 100120.3726@compuserve.com

United Kingdom

Grey Matter 

Prigg Meadow 

Ashburton Devon TQ13 

7DF UK

Tel 44-1364-654-100 

Fax 44-1364-654-200 

Email maildesk@greymatter.co.uk 

Highlander Software

106-108 Pois Street

London SE 1 8 6 LU

Tel 44(181)316-5001

Fax 44(181)316-6001

Email sales@highlander.co.uk 

Professional Software Limited

Wyvols Court, Swallowfield

Reading, Berks RG7 1PY

United Kingdom(UK)

Tel 44(0)1734 880224

Fax 44(0)1734 880360

Email info@profsw.com 

WWW http://www.profsw.com

QBS Software

10 Barley Mow Passage 



London W4 4PH

Tel 44-181-994-4842

Fax 44-181-994-3441 

Email info@qbss.co.uk

WWW http://www.qbss.com

System Science

1-6 Bradley's Close

White Lion Street

London N1-9PN

Tel 44(171)833-1022

Fax 44(171)837-6411

Email sales@syssci.co.uk

Systemstar Limited

4A Brocket Road

Welwyn Garden City 

Hertfordshire AL87TY UK

Tel 44-1707-278-300 

Fax 44-1707-268-471 

Email 100637.3301@compuserve.com



Send Message Action

Summary

The "Send Message"    action is used to send any Windows or user defined message to either the 
application objects main window or to the window with the current focus. The window receiving the 
message can then choose how to process the message.

The "Send Message" action provides a specific immediate mechanism to control an application 
window. To use the "Send Message" action, you will need to have programming knowledge as to what 
messages your application processes.

Additional Information

The "Send Message" action uses the Windows "SendMessage" API to perform its function. If the "Send 
Message" action references an application object, then the message is sent directly to the window 
controlled by the application object. Otherwise, the message is sent to the current focus window as 
determined by the Windows "GetFocus" API.



Live Application Demos

Application Fails to Launch

Creating Cross Platform Live Application Demos



Application Fails to Launch

What does DemoShield Expect?

In order for DemoShield to launch an application, it is necessary that the executable and all support 
files be present.    When properly configured, the application should launch at the beginning of a scene 
containing an Application Object.    Prior to launching the application, DemoShield checks to see if an 
instance of the application already exists.

Note        If you are using the Launch Application action, see the Launch Application Action tips article.

Potential Problem

n Application fails to launch.

n An error message is displayed when the application scene begins.

Solution

The steps required to resolve your problem depend upon whether the application has been imported 
into the DBD file or imported by reference.    To determine which method you have used, open the 
properties dialog box for the Application Object.    Select the Object Data tab.    If Import Application 
File is checked, the application has been imported into the DBD file.    Otherwise, it has been imported 
by reference. 

Imported Applications

n Determine all of the files necessary to launch your application.

n Select Resource Manager under the Demo menu.

n Select the Files tab.

n Verify that all of the files needed by your application are listed in the Files list box.    If any of the 
files use the same name, it will be necessary to use the Imported by Reference method 
described below.

n Save the Demo.

n Delete any .EXE and support files that may have been written to your TEMP directory.

n Attempt to launch the demo through the Player.

Imported by Reference

n Place the executable and all support files in the same directory, if possible.    Support files can 
also exist in these directories:    C:\TEMP, C:\WINDOWS, C:\WINDOWS\SYSTEM,    Current 
Working directory, and directories specified in the PATH statement from AUTOEXEC.BAT.

n Place DEMO32.EXE and DS32.DLL in the same directory as your executable-provided you 
accepted the defaults when installing DemoShield, these files should be located in C:\Program 
Files\InstallShield\DemoShield\Program

n Delete any .EXE and support files that may have been written to your TEMP directory.

n Open your demo in the Designer.

n Select Resource Manager under the Demo menu.

n Select the Files tab-use the Delete button to remove all Application resources.

n Open the Application Properties dialog.

n Select the Object Data tab-disable Import Application File if it is enabled



n Select the Browse button and select the executable that was moved above.

n Save the demo using a new name.

n Restart Windows.

n Launch your demo using the Player. The Player must be located in the same directory as the 
executable.



Graphics

How DemoShield Handles Colors

Metafile (WMF) Fails to Display Properly



Live Application Demo

Purpose of Demo

The Live Application Demo (LIVEAP31.DBD and LIVEAP95.DBD) demonstrates a software application 
in real-time.    A Live Application Demo consists of a .DBD file that launches a separate .EXE file (i.e., 
the application you wish to demonstrate) simultaneously.    The demo shows interactive capabilities in 
both the demo and the application.

Techniques

Under Windows 3.1, LIVEAP31.DBD launches Paintbrush, an application that comes with Windows.    
We chose Paintbrush since it resides on most every Windows system (it is installed by default with 
Windows).

Under Windows 95, LIVEAP95.DBD launches Explorer, an application that comes with Windows 95.    
We chose Explorer since it resides on most every Windows system (it is installed by default with 
Windows).

Macros (within the demo) control the application in real-time.    Event objects play these macros at 
specific times.    We recorded the macros in three resolutions (640x480, 600x800, and 1024x768) to 
work on any system.

Advantages

n Live Application Demos allow demonstration of your application in real-time... not through 
simulation

n DemoShield provides an option to enable or disable user interaction with the application

n Live Application Demos work ideally for training

Disadvantages

n When demonstrating an application, end users need the application on their system (you must 
provide it either externally or    by importing it in the demo)

n If your end users operate various Windows resolutions (640x480, 600x800, 1024x768),    you 
must record the macros in all three resolutions

n Test running of your demo requires the creation of a Program Item outside of DemoShield

Steps

Use the following steps to prepare a scene for an application:

1. Launch the Designer

2. Create a blank, new screen by choosing New Scene from the Scene menu

3. Right-click in the scene to edit the Scene Properties

4. Under the General tab, select Application Scene

5. Choose OK

6. Select the Application Object in the Object Palette

7. Left-click in the Designer window (the screen becomes cross-hatched)

8. Right-click in the cross-hatched area (the Application Object)

9. Under the General tab, provide a name for the Application Object (use a name that describes 
the application, such as "Paintbrush Application")

10. Under the Object Data tab, click the Browse button to select the application to be demonstrated



11. Choose the directory and .EXE file to demonstrate

12. Choose the OK button (the application file name is then placed in the Executable File field of the 
Application Object Properties box)

13. Deselect the Import Application File option, if you don't want to import your application

14. Under the Options tab, ensure that Maximize Application is selected

15. Under the Options tab, choose whether or not to Allow User Interaction

16. Under the Options tab, set the Application Termination field as desired

17. Under the Options tab, enter pbParent as the Class Name

Note          The Class Name is used to identify an application.    Failure to provide the Class Name and/or 
Caption can cause DemoShield to be unable to locate your application.    The 32-bit version of 
DemoShield requires that a Class Name and/or Caption be provided.    To determine the Class Name, 
you will require a developers utility such as Microsofts Spy or Borlands WinSight.    A Caption is the text 
displayed on the title bar of the applications main window (e.g., when launched, Paint Brush displays 
Paintbrush - (Untitled) as its caption.

18. Click the OK button

Use the following steps to record your macro:

1. Choose Record Macro from the Demo menu 

Note          The default macro recording key is F2.    It may be changed by going to File | Preferences, 
Configure tab, and the Macro Start/Stop Recording Key option.    The macro recording key must not 
conflict with the application where you record your macro.    In other words, don't use a key for macro 
start/stop recording if that key is already used by the application.

2. Read and make sure you understand the instructions on the Macro Record dialog box

3. When finished, hit OK

4. From the Program Manager, launch the application of your choice

5. Maximize your application

6. When ready to start recording your macro, hit F2 (or whatever you set as the Macro Start/Stop 
Recording Key)

7. Conduct your keystrokes and mouse movements as necessary 

Note          Use caution if your macro will access any buttons, pull-down menus, or other objects that 
tend to differ in size from 1) one resolution to another, or 2) large fonts vs. small fonts.    If your macro 
will access these objects, your best bet is to create keystroke-only macros.    This will ensure that your 
macro plays, regardless of resolution or system font size.    In this case, you MUST first begin recording 
your macro, then click the mouse in the window (to set window focus), and finally begin your 
keystrokes.

8. When finished recording your macro, hit F2 (or whatever you set as the Macro Start/Stop 
Recording Key)

9. When asked if you want to "Play or Save the Macro You Just Recorded?" choose Save

10. In the Macro Name field, type Macro 1 (or macro name of your choice)

11. Hit the OK button

Use the following steps to create user controls that will play the macro:

1. Click the Button Object on the Objects Palette



2. Place the Button Object somewhere in the Designer window by left-clicking

3. Right-click on the button you just made to edit its properties

4. Under the Object Styles tab, choose Push Button.

5. Under the Object Styles tab, Button Caption field, type "See Macro 1."

6. Under the Actions tab, choose the New Action Button

7. When the Build Action box appears, choose Play, Macro, Macro 1

8. Hit the OK button

9. Save your demo

Follow these steps to test your demo in the Player:

1. Choose Current Demo from the File menu

Hint          Current Demo will appear disabled if the demo has not yet been saved.



CBT Demo

Purpose of Demo

A CBT (Computer-Based Trainer) trains someone on a very specific topic.    CBTs use graphics, sound, 
animation, and interaction to get the point across.    The CBT Demo provides an example of a typical 
Computer-Based Trainer.    This demo describes the basic workings of a jet engine.    It provides some 
basic theory initially, and then delves into more detail.    Finally, tests keep the user involved.

Techniques

Computer training on a subject requires effective use of graphics, animation (where necessary), and 
interaction.    When creating your CBT, knowledge of various graphics and animation packages will aid 
in the process.    We used CorelDraw! and CorelMove to create the pictures of balloons, jet engines, 
and jet engine animations.    These images were custom-made (hence, experience in the graphics 
packages helps), however most graphics packages provide clip art and animation libraries.    Feel free 
to use these resources when making your CBT.

Your visual layout makes the difference between effective and non-effective communication.    Notice 
how all text in the jet engine CBT lies in a blue area to the left.    Also, all images appear (with exception 
of the Welcome scene) in the gray area to the right.    Thus, consistency is key.    Your user will maintain 
interest and concentrate on the topic.

Several special techniques and effects exist in this CBT:

MENU SCENE:    First, the flow chart in the menu scene updates its appearance, depending on where 
the user has been.    Global variables and event objects activate this effect.    Second, hot spots lie over 
the flow chart, so that the user can go to each lesson by clicking on the lesson name.

BASIC PRINCIPALS SCENE:    First, animation of the balloon creates an interesting, yet efficient 
special effect.    Because .AVI files can be quite large, we avoided using one here.    Instead, we 
duplicated the original balloon (in diminishing sizes) and placed them in a straight line.    Each object 
appears on-screen, in sequence, through proper timing.    This disk-space-saving method of animation 
presents an alternative to .AVI files.    Second, since other interactive objects exist in the scene, we 
used the Pause/Continue action to make the animation work at the appropriate    time. 

BASIC PRINCIPALS TEST SCENE:    Our multiple-choice quiz creates the perfect interaction 
opportunity.    Radio buttons provide possible answers, however a group object becomes necessary in 
this case.    Each radio button is included in the group.    Also, each radio button is programmed to 1) 
display the appropriate "correct" or "wrong" text when clicked, depending on the answer, and 2) disable 
the group object when clicked.    This prevents the user from "cheating" by clicking buttons until the 
correct answer is found.

PARTS SCENE:    The gray graphics area displays the engine and its respective parts buttons.    Each 
button displays 1) an arrow that points to an engine part, 2) appropriate text, and 3) a separate button 
that plays an .AVI file.    Again, the group object groups all arrows.    When the user clicks an engine part 
button, an action hides the group object.    With the group object hidden, all arrows disappear.    
However, each button also shows only the arrows that correspond to the part.    Thus, when using a 
group object, all objects included in the group are affected by actions performed on the group.    You 
may still show, disable, etc., any individual objects in the group without affecting the remaining objects.

PARTS TEST SCENE:    To test the user, edit fields break up the monotony of multiple-choice 
questions.    The user clicks in the edit field and types the answer.    An event object compares each edit 
field against a constant string.    If the comparison matches (i.e., the comparison is true), a "correct 
answer" message    is displayed.    If the comparison does not match, (i.e., the comparison is false), a 
"wrong answer" message    is displayed.    The demo pauses at 0 seconds (through a separate event 
object) before making this comparison.    Thus, the scene follows this sequence:

1. edit fields appear



2. the demo is immediately paused (at 0 seconds)

3. the user types in    their answer (by pausing the demo at 0 seconds, the user has an infinite 
amount of time to provide    the answer) 

4. the user clicks the "All Done" button, which continues the demo

5. Event objects, placed at second 1, compare the contents of their respective edit fields with the 
correct answer (or string)

6. depending on the results (true or false), the appropriate "correct answer" or "wrong answer" 
message    appears

Advantages

n CBT education is more exciting than other educational media through the effective use of 
graphics, sound, animation, and interaction

Disadvantages

n Creation of a CBT sometimes requires experience with separate graphics, animation, and sound 
packages

Steps

Use the following steps to create a menu flow chart item that changes appearance, depending on 
where the user has been:

1. Create a new scene with a name of Menu Scene

2. Create a text object with a solid gray background and a name of SubjectNotDoneText

3. With SubjectNotDoneText selected, choose Copy, then Paste from the Edit menu

4. In the Scene Editor, double-left-click on the newly pasted text object (should be Text 1, by default) 
to edit its properties

5. Change the background color to red, provide a name of SubjectDoneText, and make the object 
invisible

6. Create a new scene with a name of Subject Scene

7. Return back to the Menu Scene

8. Create a hot spot over the text objects, with the action:

Perform the action...Go To Scene

Scene...Subject Scene

9. Switch to the Subject Scene

10. Create a button anywhere in the scene with these two actions:

Perform the action...Set Variable

For Variable...Variable1(Global)

In Scene...Subject Scene

Operator...Assign Value

To this value...1

Perform the action...Go To Scene

Scene...Menu Scene

11. Switch back to the Menu Scene



12. Create an event object, set at time 0

13. Under the event object's Comparison tab, create the comparison :

If this object/variable...(Global Variable)

(Global Variable)...Number1(Global)

is...Equal (=)

this object/variable...(Constant)

Numeric Constant...1

14. Under the event object's True Actions tab, create the actions:

Perform the action...Hide 

object...SubjectNotDoneText

in scene...Menu Scene

Perform the action...Show

object...SubjectDoneText

in scene...Menu Scene

Use the following steps to create a simple animation effect:

1. Create a graphic object containing an image, with a Start time of 0, Hold time of 1, End time of 1, 
and Exit time of 2.    Create a Start Effect of Random Pattern Appearing, and an End Effect of 
Random Pattern Disappearing

2. Duplicate the object and place the new object where you wish.    Set the Start time to 1, Hold time 
to 2, End time to 2, and Exit time to 3.

3. Repeat step 2 as many times as necessary to create the animation effect.    To make the object 
appear to move away, resize each copy to be smaller than the previous one. 

Use the following steps to make a multiple-choice question that uses a group object:

1. Create a text object that asks a question.

2. Create a text object with a name of CorrectText.    Provide text under the Object Styles tab that 
reads, "Your answer is correct."    Make the object invisible.

3. Create a text object with a name of WrongText.    Provide text under the Object Styles tab that 
reads, "Your answer is incorrect."    Make the object invisible.

4. Place a group object in the Designer window.    Under the General tab, provide a Name of Group 
1 and a Group Name of Answer Group

5. Create a radio button.    Under the Object Styles tab, provide a caption that represents an 
incorrect answer.    Under the General tab, provide type Answer Group in the Group Name field.    
Create the following actions:

Perform the action...Disable

Object...Group 1

in scene...<whatever the current scene happens to be>

Perform the action...Show



Object...WrongText

in scene...<whatever the current scene happens to be>

6. Duplicate your "incorrect answer" radio button (step 5) two or three times.    Provide a caption for 
each button that represents an incorrect answer.

7. Duplicate your "incorrect answer" radio button (step 5) once.    Provide a caption that represents a 
correct answer.    Create the following actions:

Perform the action...Disable

Object...Group 1

in scene...<whatever the current scene happens to be>

Perform the action...Show

Object...CorrectText

in scene...<whatever the current scene happens to be>

Use the following steps to check what your user types in an edit field:

1. Start with a blank scene.

2. Place an edit field in the Designer window.    Provide a name of EditField, and set your desired 
options under the Object Styles tab.

3. Create an event object that occurs at time 0 seconds, with this selection under the Comparison 
tab:

With this object/variable...(always)

and this action under the True Actions tab:

Perform the action...Pause/Continue Demo

4. Provide a button with a caption of "Click when finished typing," and this action:

Perform the action...Pause/Continue Demo

5. Create a text object with a name of CorrectText.    Provide text under the Object Styles tab that 
reads, "Your answer is correct."    Make the object invisible.

6. Create a text object with a name of WrongText.    Provide text under the Object Styles tab that 
reads, "Your answer is incorrect."    Make the object invisible.

7. Create a second event object that occurs at time 1 second, with this selection under the 
Comparison tab:

If this object/variable...EditField

with this property/value...General Data Property

is...Equal (=)

this object/variable...(Constant)

String Constant...<whatever the edit field should read in order to be correct, in the exact 
order and fashion>

Then, under the True Actions tab for this event object, create this action:

If the comparison is true, perform the action...Show

object...CorrectText



in scene...<whatever happens to be the current scene>

Then, under the False Actions tab for this event object, create this action:

If the comparison is false, perform the action...Show

object...WrongText

in scene... <whatever happens to be the current scene>

Follow these steps to test run your demo in the Player:

1. Choose Current Demo from the File menu

Hint          Current Demo will appear disabled if the demo has not yet been saved.



Making Your Demo Easy to Use

n If your demo contains several topics and/or subjects, use menus to provide navigation control.    
For instance, use the Menu object, or place several buttons in a row to provide the necessary 
options.

n If your demo contains a menu, indicate what areas your user has reviewed.    For instance, build 
your demo to automatically place a checkmark or other object next to each menu item after 
completion.

n If your menu items require some description during the menu scene, provide text or sound that 
describes them.    For instance, build an action for each menu button that shows a short, 
descriptive text object when the cursor is moved over the button . Program the button to go to the 
topic when clicked.

n If your demo lists several features of your product or service, provide text or sound that describes 
them in greater detail.    For instance, place a hot spot over each feature that shows a short, 
descriptive text object when the cursor is moved over the feature.

n If there's a chance that your demo will have multiple versions (i.e., languages, more current 
releases, etc.), provide an "about" box or scene.    About boxes are useful for management 
purposes and they add to your professional image.

n If your user might be unfamiliar with computers or any aspect of your demo, provide a help 
feature.    For instance, place a button on every scene that goes to a help scene.

n If your demo uses technical terms or vocabulary that is new to your user, provide a glossary of 
terms.    For instance, create a menu option that allows the user to go directly to the glossary.    
Also, allow your user to access any part of your glossary from any part of the demo.

n If your demo contains no interactive branching (i.e., the user must consistently click the Next 
button to move ahead), tell the user at the start that they must click the Next button throughout 
the demo.    For instance, on the first scene, provide an arrow or outline of the Next button with 
clear, bright instructions stating, "Click the Next button to start!"

n If your demo is designed so that nothing happens after your user has read a block of text, provide 
them with instructions on what to do next.    For instance, if a user is to view several bullet points 
in a scene, provide text at the bottom that reads, "Please click the Next button when finished."

n When describing a feature, always inform your user what will happen, or why it will happen.    
Then, show the actual feature by giving a simple example.    Finally, re-inform the user what 
happened or why it happened.    This ensures that the feature will be understood.    Remember 
these steps: 1) tell them what they'll see, 2) show them, 3) tell them what they saw.

n If your demo contains items that are related in some way, link them in a visual manner.    For 
instance, create your glossary with its own independent color scheme.    Then, provide a Go To 
Glossary button elsewhere in the demo that uses the same color scheme used by the Glossary.

n If your demo uses text to describe a point, use illustrations wherever possible to make the same 
point.    For instance, besides describing how air molecules enter an engine intake, show an 
illustration or animation of molecules flowing into the engine. 

n If your demo uses a certain button consistently (i.e., Next or Back), make the button look disabled 
when it cannot be used (another method is to not display the button when it is not used, however 
this gives the appearance that it was mistakenly omitted .     This is not recommended).    For 
instance, suppose your button is normally gray with black text.    When it is not to be used, make it 
look disabled by showing an identical button with white text (make sure to disable it also).

n Do not start text explanations by naming a feature and telling what the feature does.    Instead, 
explain when your customer would want to use a feature, then name the feature you offer, and 
how it works.    For instance,    "If you want to calculate the balance, just click on Calculate, and 



our spreadsheet calculates the complete balance, including shipping costs."



Creating a Good Demo

Placement of Objects

n Keep objects aligned in a scene... link the objects in a visual manner.

THIS

NOT THIS

n Keep a common color scheme or background for the same topic.    Switch background colors only 
when the user is digging into a topic.    For example, use a blue wash background for scenes that 
deal with your main topic.    Use a purple wash background for any type of subscene.    
Remember, when in doubt, keep the colors simple.    We at DemoShield Corporation usually use 
no more than 3 different scene backgrounds.    We keep the colors simple.

n When showing a screen that has a number of topics/buttons from which the user can choose, 
don't use a different color for each button or screen unless you have a really good reason.    
Everything doesn't have to be in a different color to communicate effectively.

n Establish styles (color, size, placement, etc.) for scene-common objects.    With titles, for instance, 
1) keep them in the same position from scene to scene, 2) use the same font, size, and color, and 
3) display them consistently (always shown, etc.).

n Establish locations for certain object types and be consistent.    As an example, 1) place titles in 
the upper-left corner, 2) keep text in an area to the left, 3) place images in an area to the right, 4) 
put all buttons near the bottom, etc.

n Regarding buttons, use small (8-, 10-, or 12-point) text and keep the height relatively small.    This 
adds a sophisticated look.

n Make your exit button look different from navigational or menu buttons.    Also, use a subdued 
color and a small size for your exit button - don't encourage your user to quit your demo.

n For your background, choose complementary colors (e.g., rose, pink, and purple).    For text, use 
contrasting colors (e.g., yellow    against blue, or light gray against dark green).    Never use dark 
text against a dark background, or light text against a light background.    When choosing colors, 
remember - the higher the RGB    value, the lighter the color.

n Regarding motion and special effects, pick and use only one or two styles    and stick to them.    
The use of too many types of motion and special effects distracts the user from the information in 
your demo.

n When using an arrow to highlight an object on the screen, keep the stem short and thick.    If you 
are labeling something in your demo using both text and arrows, use thin, long arrows to point 
from the text to the graphic.

n Keep arrowheads the same color as the stem.    Make arrows noticeable either through bright 



colors, or contrasting colors.

n When you want to think of pleasant contrasting colors, think of sports team uniforms.    Many have 
classic contrasting color schemes.

n When you want to think of colors that match nicely, think of cars and their interiors.    Blue and 
light blue, deep green and tan,    red and gray, gold and tan,    yellow and black,    white and navy, 
black and silver, etc.

n Always use some black and some white in your color scheme.    This will give your demo a 
professional look.

n For creating captions for screen captures or live application scenes, use text with a solid, colorful 
background, and text that contrasts with the background, like black/white, yellow, blue.    Think of 
this look as the "caption" style.

n Maintain a reasonable margin (e.g., 1 inch) from all edges of a scene.    In other words, keep your 
objects away from the edges.    This will give your demos a sophisticated look.

n Don't put objects near the edges unless you want to create visual interest which will cause the 
user to draw their eyes to the object. 

n When creating a group of interactive buttons for a list of topics, etc.,    create the button with the 
longest text first, then copy this button to create the other buttons.    Then simply change the 
button text for each button. 

Text

n When using a solid fill style on a text object, use a margin of a few pixels between the text and 
the box that it fits in.

n Don't use fonts other than Times New Roman or Arial.    Nearly every Windows system contains 
these fonts.    If you use a font that resides on your system, but not your users systems, they may 
not be able to read any of your text.

n If you absolutely must use a specialty font that your users won't likely have on their systems, 
create the text in a graphics program (e.g., CorelDraw!).    Save the text as a Bitmap (.BMP), and 
import the text into the demo as a graphic object.

n Times New Roman is generally more attractive than Arial.    Use Times New Roman whenever 
possible, as it lends a certain degree of sophistication to the demo.    Times New Roman is also a 
serif font, and thus easier to read in small point sizes.

n Avoid using bold text, and keep your use of italics consistent.    Bold is fine for headlines but it is 
hard to read on body copy.    Create body copy in normal or italic style.

n Remember that even plain typefaces like Arial and Times New Roman can be very attractive if 
you use a point size that is not too large.    Smaller, non-bold type can be fairly elegant.

n For added type appeal, try "letterspacing" headlines by typing a character and inserting a space 
or two, then another character, and so on. Remember, this is not effective for body copy, only 

headlines/titles.    It looks like this...    W    I    N    D    O    W    S.

n Use lines of text that are only 5 to 6 words long.    Users will not read a text block of 10-point text 
that stretches from side to side.    In fact, by adopting a newspaper column-style look (short lines), 
readability will increase.

n Avoid using effects on text that reveal from bottom to top, or right to left.    Since we read left to 
right and top to bottom, use these effects instead.

n Heavy lines and borders near text or on a box surrounding text can detract from the readability of 
the text.

Demo Technique



n When making a timed demo (i.e., the demo proceeds at its own pre-set pace), ensure that your 
text stays on-screen long enough to be read.    A good way to test this is by timing the demo while 
someone who is completely unfamiliar with the subject reads the text.

n When making interactive demos, use the Pause On Scene transition (found in the scene 
properties box).    This enables a scene to stay on-screen for an infinite period.    Then, program 
an event object or button to go to another scene as necessary.

n When using captures or any type of bitmap where you need it to display 1:1 (i.e., not scaled), 
select the Resize Frame option when editing the object's properties.

n Make all effects and motions relatively fast.    Users become tired when waiting for effects or 
motions to finish.

n Use 16-color bitmaps wherever possible, especially with backgrounds.    Some image editing 
applications are better than others for converting true-color and 256-color images to 16-colors.    
Youll need to experiment.

n Provide some method for your viewer to move from one part of the demo to the other.    Nothing is 
more boring than sitting through a 15-30 minute 'slide show' to get to the end of the demo.

n Provide a thank you screen when your viewer chooses to exit your demo.    It is polite, and gives 
you an opportunity to show them the contact information again.

n Long demos can get boring or tiring.    Notice that we have split demos into different topics, so 
each is easy to view in one sitting.



Helper Applications Used for Demos

CBT.DBD

The F-16 jet fighter image on the Welcome scene was generated with Corel PhotoPaint 5.    The image 
was taken from the Corel Sampler CD, and was resampled to 20%.    Then, it was converted to 16-
color. 

CorelDraw! 5.0 was used to generate the images of the balloon and jet engine, which were exported as 
.WMF files.

The .AVI files were made with CorelMove 5.    For those familiar with CorelMove, a single actor was 
created from CorelDraw! 5 that included the image of the jet engine and the air molecules flowing 
through it.    To generate each frame of the .AVI file, the air molecules were moved forward, frame-by 
frame.

CUECARD.DBD

On the opening scene, the small image of the mouse was created with several applications.    The 
mouse was obtained from the PhotoFinish 3.0 PhotoLibrary CD.    Corel PhotoPaint 5 was used to crop 
the image, and several bitmaps of DemoShield buttons were merged into the image, with some opacity. 
The image was converted to 16-color using U-Lead ImagePals Image Editor. 

Also, the beveled appearance was created using a .WMF.    CorelDraw! 5 was used to generate a 
transparent box, with two sides white and two sides dark gray.    The box was exported as a .WMF.    In 
the demo, the box was placed over text objects and was scaled vertically to fit certain lines of text.

MULTI.DBD

In the attention-getting scene, a newspaper page image was made in CorelDraw! 5.    This image was 
printed on a laser printer, and the paper output was folded and crinkled.    Then, in Corel PhotoPaint 5 
using an HP ScanJet IIc, we scanned the paper output of the newspaper page as a "color photo," thus 
giving the scanned image a slightly gray/yellow newspaper look.    We used a mask to cut-out the 
image, copied it to the clipboard, and then pasted it into a city street image that was obtained from the 
U-Leads photo CD.    We now had the newspaper superimposed over the city street.    Finally, the 
Lighten/Darken tool in Corel PhotoPaint 5 was used to hand-touch a shadow near the edges of the 
newspaper.

The WAV file played in the attention-getting scene was found on a collection distributed by ARIS 
Entertainment.    It was resampled to 11 KHz using WAV for Windows by Turtle Beach.

The background of the remaining scenes was created in Corel PhotoPaint 5 as a fractal-fill 640x480 
bitmap.    The beveled-box appearance was created with the Lighten/Darken tool.    The image was 
converted from 256-color to 16-color using HiJaak PRO.    We found that HiJaak PRO did an 
exceptional job of converting a complex image to 16-color.

The slideshow images in the menu scene and additional bitmap images in other scenes were obtained 
from various photo CD's.    Corel PhotoPaint 5 was used to resample (reduce) them, and text was 
added there as well.    They were saved as 256-color bitmaps.

During the pricing/availability scene, logos were made using CorelDraw! 5, and they were exported 
as .WMF's. 

Finally, the animation file during the technical specifications scene was obtained from the Corel 5 clipart 
CD.    This animation, originally in FLI format, was converted to the AVI format using Microsoft's VidEdit 
utility.    The compression scheme used was: 8 bit Microsoft Video 1, 14 frames per second (fps), with a 
data rate of 300 K/second.    The palette was optimized to 234 colors to improve the display of the AVI 
under 256 color systems.

PRESALE.DBD

Screen Captures were performed using Paint Shop Pro version 3.0 by JASC, Inc. Some images were 



resized using Smooth Scaling by WexTech Systems, Inc.

Graphics were created using Micrografx Picture Publisher and exported as BMPs.

TOUR.DBD

Screen Captures were performed using Paint Shop Pro version 3.0 by JASC, Inc.

In addition to screen captures, images were used to explain certain concepts.    These images were 
drawn in CorelDraw! 5, and they were exported as .WMF files.

The title bars were created by scanning a sheet of aluminum foil and resampling (resizing) it to 
1024x768 size.    It was then cropped to the desired size.    HiJaak PRO was used to convert the image 
to 16-color



Quick Tour Demo

Purpose of Demo

The Quick Tour demo provides new users with an overview of the interface and capabilities of 
DemoShield.    The viewer navigates via hot spots placed on top of graphics.    When the viewer sees 
information within either the Tools or Wizards topic, he may click on See It! to see a demonstration of 
the feature being used.

Techniques

Several different techniques are used in this demo.    First, we carefully planned the content and 
organization of the demo.    Then we created an interface that could relate a good deal of information in 
a manner which maintains the viewer's interest.    We decided that the theme for the demo would be a 
vacation (i.e. Quick Tour) and the text descriptions (except for    those used in the See It! button within 
the demo) would be written along these lines.

We created the graphics in CorelDRAW and generated AppCam files using DemoShield's built-in 
image sequencing functionality.

Hot Spot Objects were used to provide navigation.    Event Object's were used to allow us to jump 
forward or backward in time within a single scene.    This allowed us to create a fade in fade out effect 
when moving the mouse over a Hot Spot.

The following techniques were used in the various scenes:

MAIN MENU

We created several bitmap images which are displayed or hidden when the user moves the mouse 
over a hot spot.

TECHNICAL SUPPORT/CONTACT INFO

A Text Object is used to display information about contacting DemoShield technical support and sales.

M-[ALL], T [ALL], and W [ALL]

A single Text Object with scroll bars is used to display information about each menu item one by one.    
See It! is unavailable for all Menu topic items.    In the other topics (Tools and Wizards), clicking on See 
It! will send the viewer to a separate scene playing an AppCam.    Each scene has a unique image 
which ties in with the text description.

... SEE IT [ALL]

AppCam recordings were created of each feature being used.    The size and placement of the AppCam 
Objects are consistent in all scenes displaying them.    A Text Object is used to explain what the viewer 
is seeing in the AppCam Object, and Event Objects trigger Delay Demo actions to hold the text on the 
screen for the desired number of seconds.

Advantages

n A quick overview of DemoShield is provided in a manner that retains viewer interest

n Many of the graphics used are visually appealing

n The interface is easy to use

Disadvantages

n Creating custom images requires familiarity with graphics programs and graphic design skills

n The fade in/fade out effect used on buttons is a somewhat complex implementation

n Playback of the demo on 16 color systems will not display images correctly as all bitmaps are 256 
color



Steps

To display a bitmap do the following:

1. Create a Rectangle Object from the Auto Shapes palette.

2. Open the Rectangle Object properties dialog by double clicking on the object.

3. Select the Fill Styles tab.

4. Choose the desired image from the Images listbox.    If the image you wish to use is not listed you 
may import it by clicking the Import Image... button.

5. Choose Resize Frame as the Image Option.

To display an image when the mouse moves on top of a Hot Spot Object and hide an image when the 
mouse moves off of the Hot Spot Object, do the following:

1. Create a Rectangle Object using the steps above (e.g. Menu Top in the Main Menu scene).

2. Disable the Visible Property in the Rectangle Object's Properties | General tab | Initial State.

3. Create a Hot Spot Object (e.g. HS Menu Top in the Main Menu Scene).

4. Open the Hot Spot Object's properties.

5. Choose the Actions tab.

6. Click the New Action button.

7. When Mouse Moves On Object, perform the Show action upon the desired object (e.g. G Menu 
Top) for Scene Duration.

8. When Mouse Moves Off Object, perform the Hide action upon the desired object (e.g. G Menu 
Top) for Scene Duration.

To create a Text Object with scroll bars, do the following:

1. Create a Text Object (e.g. T Cue1 in the Technical Support scene).

2. Choose the Object Styles tab and enter the desired text.

3. Choose the Borders tab.

4. Enable Add Scrollbar.

To create buttons that fade in when the user moves the mouse on top of them and fade out when the 
user moves the mouse off of them, do the following:

1. Create two bitmaps in a graphics program.    One bitmap represents the button when it is not 
glowing and the other is for when the button is glowing.

2. Create Rectangle Objects to display the bitmaps using the steps above.    Place one directly on 
top of the other and disable the Visible property on the object that displays the glowing bitmap 
(e.g. G Main Menu Glow in the Technical Support scene).

3. Create an Event Object that causes the scene to replay if the user has not moved the mouse on 
top of the button (e.g. E 89.0 Replay Scene in the Technical Support scene triggers a Go to 
Scene action sending the user back to 0.0 seconds in the Technical Support scene).

4. Set the Start time of the Rectangle Object displaying the glowing bitmap to greater than the 
trigger time of the Event Object created in step three above (e.g. G Main Menu Glow in the 
Technical Support scene has a start time of 90.0 seconds).

5. Configure the remaining life periods as follows:

Hold = Start Time + .01 second (e.g. 90.1)

End = Start Time + 20.1 seconds (e.g. 110.2)



Exit = Start Time + 20.2 seconds (e.g. 110.3)

6. Choose Random Bits Appearing as the Start Period Effect and Random Bits Disappearing as 
the End Period Effect.

7. Create an Event Object whose trigger time is greater than the Hold time on the Rectangle Object 
created in step four (e.g. E 92.0 Jump Main Start in the Technical Support Scene). This object will 
not perform any actions.    Instead it will be used to create a loop - trapping scene time in the 
Rectangle Objects object's Hold Period until the user moves the mouse off of the Hot Spot.

8. Create an Event Object whose trigger time is less than the End time of the Rectangle Object 
displaying the glowing bitmap (e.g. E 110.0 Jump Main End in the Technical Support scene has a 
trigger time .02 seconds less then the End time of G Main Menu Glow). This object will not 
perform any actions.    Instead it will be used to jump to when the user mouse the mouse off of the 
Hot Spot.

9. Create a Hot Spot Object on top of the image of the button (e.g. HS Main Menu in the Technical 
Support scene).

10. Open the properties of the Hot Spot Object and choose the Actions tab.    Configure the Hot Spot 
as follows:

When the viewer does this Perform These Actions

Left Clicks Mouse Trigger the desired action (e.g. Go to Scene)

Moves Mouse On Object Go to Object in Scene (e.g. G Main Menu Glow)

Moves Mouse Off Object Go to Object in Scene (e.g. E 110.0 Jump Main End)

Tip          To see this technique in action, view the Quick Tour demo through the Designer and pay 
particular attention to the Demo Controller.    You will see the changes in Scene Time when moving the 
mouse on top of the Hot Spot.    Also, related objects (e.g. from the Technical Support scene: HS Main 
Menu Glow, G Main Menu Glow, E 92.0 Jump Main Start, E Go to 92.0 Jump Main Loop, and E 110.0 
Jump Main End) have been layered in such a way that they will be located next to one another in the 
Time Line Editor.

Hint          Come up with a naming scheme that can be used consistently in more then one scene.    This 
way you can create a scene to be used as a template for future scenes.    Also, if you need to alter the 
demo at some future time, you will be able to easily familiarize yourself with how the demo is 
organized.

See Also

AppCam FAQ

AppCam Tips



Capturing Images

DemoShield has a built-in screen capturing tool.    This allows you to capture your application screen 
images in bitmap format.    You can then use the bitmaps within your demo. Captured images become 
internal resources of the current demo.

Follow these steps to create screen captures:

1. Select Capture Images from the Demo menu. The Designer will become minimized and the 
DemoShield Capture dialog will be displayed.

2. Open the application you wish to capture and prepare the screen the way you want it to look. 

Note          Be sure that the application is small enough to fit within the dimensions of your Demo 
playback window.

3. Choose the type of capture you would like to perform by pressing the Shift key to toggle through 
the options.

4. Press Control to perform the capture 

5. Press Done when you have finished capturing images

See Also

Image Capture Tips



Common Questions

Why does my xxxxxxx Object drift from its original position?

This problem is related to the resolution that you are running Windows under.    If you are running in 
VGA resolution (i.e., 640 x 480), then the Design window will be a scaled representation of the actual 
demo.    Therefore objects placed within the Design Window attempt to approximate their true 
coordinates.    This can result in objects shifting or drifting a couple of pixels.    In order to eliminate this, 
you need to enable the Scrollable Design Window view.    To do this, do the following:

1. Select Preferences from the File menu

2. Select the Enable tab

3. Enable Scrollable Design Window

Why does my Bitmap look distorted?

Bitmaps can become quite distorted when resized.    The greater the amount of size change, the more 
distorted the image will be.    To avoid distortion, you will need to disable scaling or use a third party 
scaling program (e.g., Smooth Scaling) to resize the image.    To disable scaling, do the following:

1. Open the Graphic Objects properties dialog

2. Select the Fill Styles tab

3. Use Resize Frame as the Image Option

The Resize Frame image option will resize the object so that its new dimensions match the dimensions 
of the bitmap.

Why does my Bitmap appear in the upper left hand corner?

Objects appear in the upper left hand corner if    they are not scaling.    Scaling is the resizing and 
repositioning of objects in response to    the resolution Windows is running under.

Scaling may or may not be desirable.    Here are some Pros and Cons:

Pro

n A full screen image under 640x480 will always fill the entire screen under any resolution.

n There will not be any empty region on the right and bottom portions of the screen.

Con

n It is not possible to get exact placement of objects, as objects will scale their position according to 
the X, Y coordinate of the screen's upper left hand corner.    This is a problem when you are 
layering objects.

n BMPs and WMFs tend to become distorted.    The greater the scaling, the greater the distortion.

You might consider creating a fixed size Windowed Mode demo to avoid having to deal with scaling.    
This simply means that your demo will run in a window.    See the Windowed Mode Demo tip.

Why is the size of my xxxxxxx Resource zero bytes?

When the size of a resource as listed in the Resource Manager is zero bytes, it indicates that the 
resource has been imported by reference.    When you import a resource by reference, a zero byte pointer to 
an external resource is imported in place of the actual file.    In order for Import by Reference to operate properly, 
the resource that has been referenced must be in the current working directory.    The current working directory is 
the directory from which the Designer or Player is being launched.

What graphics formats are supported?

DemoShield supports the following graphics formats:



BMP-Windows Bitmap

WMF-Windows Metafile

There are some restrictions with these two formats.    See below.

1. WMF images should not use an optimized palette.    Instead, use the Windows palette. 
DemoShield will realize a palette for BMPs and DemoShield generated objects, however, WMF 
will use the current palette.

2. WMF should use Aldus placeable headers if you wish to be able to resize the image.

3. RLE encoded BMPs are not supported.    Use Windows RGB Encoded BMPs instead.

Note          Some applications use RLE encoding to compress bitmaps.    To avoid this, save bitmaps as 
uncompressed.    DemoShield will compress the bitmap once it is imported.

Why does my macro only playback mouse movements?

If an application does not have focus, then events such as mouse clicks will not be sent to the 
application.    To make certain that your application has focus, simply make the first event a left-click on 
your application after you have begun recording the macro. 

Note         To preview your demo as your viewer would see it, you must use the Player.    See Previewing 
a Demo.

Why doesn't the mouse move the way I recorded it in my macro?

Proper macro playback is dependent upon the screen resolution.    If a macro is recorded under VGA 
resolution (640X480) and then played back under SVGA resolution (800x600),    the mouse movements 
will be off.    It is necessary to record a macro at each resolution when mouse movement is to be a part 
of the macro playback . DemoShield will automatically play back the    macro under    the 
appropriateresolution.    Because of this, it may be desirable to use keyboard commands instead of 
mouse movements.    A macro using only keystrokes can be recorded and played back under any 
resolution. 

Note        When recording macros under different resolutions, use the same name for all of the macros. 
DemoShield will automatically append the resolution in brackets after the macro name.

Why doesn't my ScreenCam Movie (SCM) play?

In order to play back an SCM, it is necessary that the ScreenCam Player (SCPLAYER.EXE) be in the 
same directory as the DemoShield Player (DEMO.EXE).    Check the following:

1. Locate the directory containing the DemoShield executables

2. Verify that SCPLAYER.EXE is in the same directory as DEMO.EXE

It is necessary to preview your demo using the Player in order to see the SCM play.    See Previewing a 
Demo. 



Windowed Mode Demos

If you have created a demo and found that objects appear in the wrong places when the demo is 
played full screen, then you might consider trying a Windowed Mode demo.    A Windowed Mode demo 
is simply a demo that plays in a window.    This window can be of a fixed size or it can scale just as a 
standard full screen demo would.    Creating a fixed size window has the advantage of appearing in a 
consistent manner under all display resolutions. 

You could also allow your demo window to scale.    Your windowed demo will scale from a presumed 
base resolution of 640 x 480.    We recommend trying both formats to see which works better for you.

To create a fixed size window do the following:

1. Select Properties under the Demo menu

2. Select the Styles tab

3. Enable the Windowed Playback Style property

4. Enter the desired caption in the Caption edit field (a caption is the text that appears at the top of 
a window)

Tip          It is recommended that you enable Eliminate Caption if the demo will be run on systems with 
a display setting equal to the size of the demo (e.g., a 640x480 window playing back on a system 
running Windows at 640x480).    Since a caption takes up the top 20 pixels of the window, the contents 
of the window are scaled slightly and this can cause objects to    line up improperly or line breaks to 
occur in your text in undesired locations.

5. Select the Size tab

6. Enter 640 in the Width edit field and 480 in the Height edit field

Tip          Only use a size greater than 640x480 if you are sure that the user will be running Windows at 
a resolution equal to or greater than the size you have specified.    Otherwise objects will scale 
significantly and images may appear distorted.

7. Enable the Fixed Size property

8. Enable the Centered property if you wish to center the demo on the screen

To create a scaling window do the following:

1. Select Properties under the Demo menu

2. Select the Styles tab

3. Enable the Windowed Playback Style property

4. Enter the desired caption in the Caption edit field (a caption is the text that appears at the top of 
a window)



How...

How Can I Convert Slides From PowerPoint?

How Can I Create a Template?



Previewing a Demo

Some things cannot be previewed in the Designer (e.g., an Application Scene, ScreenCam playback, 
etc.).    Therefore, you will need to test run your demo using the Player.

Follow these steps to test your demo in the Player:

1. Choose Current Demo from the File menu

Hint          Play Current Demo will appear disabled if the demo has not yet been saved.



File Information

Directory Structure

When you install DemoShield, SETUP.EXE creates the following directory structure underneath the 
specified installation directory:

\PROGRAM Contains DemoShield Program Files

\PROGRAM\LEX Contains support files for the spell check functionality

\PROGRAM\DEMOTEMP Contains resources used by the New Demo Wizard

\PROGRAM\SERVER* Contains resources used by the DemoShield Server

\PROGRAM\INTERNET* Contains installations for DemoShield DemoNow. 

\SAMPLES Contains sample DemoShield demos

\TEMPLATE Contains demo Templates used during demo construction

\TOOLS Contains DemoShield Knowledge Base files

\WIZARDS Contains DemoShield Setup Wizard

* 32 bit only

DemoShield Files and File Extensions

DESIGNER.EXE

Demo developer's version of DemoShield. This is the file you use to create and edit demos.    In the 
user's guide, we call this file the Designer.    Do not distribute DESIGNER.EXE to your viewers (people 
who will run and watch your demo).

DEMO32.EXE

32 bit run-time version of DemoShield. This is the file your viewers use to run your demo.    In the user's 
guide, we call this file the Player.    Copy this file with your demo file to the disk you distribute to your 
viewer.

DEMO.EXE

16 bit run-time version of DemoShield. This is the file your viewers use to run your demo.    In the user's 
guide, we call this file the Player.    Copy this file with your demo file to the disk you distribute to your 
viewer.

NPDSINST.EXE

Netscape Plug-in installation for DemoShield DemoNow.

WEBDEMO.CAB

Internet Explorer ActiveX control used by DemoShield DemoNow.

DS32.DLL

32 bit DemoShield event generator. DEMO32.EXE and DESIGNER.EXE both need this file to run.    
Copy DS32.DLL to any disk you distribute to a viewer (along with your demo file and DEMO32.EXE).

DS.DLL

16 bit DemoShield event generator. DEMO.EXE needs this file to run.    Copy DS.DLL to any disk you 
distribute to a viewer (along with your demo file and DEMO.EXE).

SSCE4232.DLL (32 bit DemoShield only)

Support file used by the spell check functionality in the 32 bit version of DemoShield



SSCE4216.DLL (16 bit DemoShield only)

Support file used by the spell check functionality in 16 bit version of DemoShield

DEFAULT.TPL

A default template file that loads automatically if the previously loaded template is unavailable.

*.DBD

When you create a demo and save it, the extension of the file you save is DBD.    The *.DBD file 
contains all the information the Player (DEMO32.EXE) needs to run your demo.

*.TPL

A file containing object, scene, and demo template information.

*.ISU

Log file created by unInstallShield.    The information contained in this file will be used when removing a 
program from your system.

*.AAA

When you create an Automation Resource it will receive this extension.

*.WID file

MIME type created when an Internet Save is performed within the Designer.

*.SCE

Each scene will receive an .SCE extension when an Internet Save is performed within the Designer.

*.RES

Each resource in a demo will receive a .RES extension when an Internet Save is performed within the 
Designer.

*.TLX

Dictionaries used by the spell checking functionality

*.CLX

Compressed dictionaries used by the spell checking functionality



Reducing the Size of Your Demo

Use the following guidelines when constructing your demo to keep the file size as small as possible.

n If capturing AVI files, only capture the part of the screen that changes.    The Screen Capture 
program distributed by Microsoft allows you to select a portion of the screen to capture.    There is 
no need to record the entire screen if there activity in only a small portion of it.

n When capturing bitmaps, only capture that part of the screen that has changed.    For example, if 
you are displaying an image of your application and then show the mouse move to select the File 
menu, capture only the File menu being pulled down and display this image on top of the full 
screen image.

n Set your screen resolution to 640x480 and your system colors to 16 when performing screen 
captures of an application.    Most applications are developed using only the standard 16-color 
palette.    Use this to your advantage.    Change the display driver Windows is using (consult your 
video hardware documentation).    A 16-color bitmap will be smaller in size and will load faster.

n Reduce the bit depth of 256-color and true color images to 16 colors.    Programs such as Hijack 
Pro and Paint Shop Pro can be used to take a 256-color (or greater) image and reduce it to 16 
colors with a minimal loss of quality.

n Purge unused resources from the *.DBD file.

Do the following in the Designer:

1. Open your Demo in the Designer

2. Select Resource Manager from the Demo menu

3. Choose the Images tab

4. Press the Check button. Resources    in use will appear with a check mark next to it. 

5. Select any unused images from the listbox and delete them using the Remove button

6. Repeat steps 4and 5 for each type of resource contained within the demo accept 
Macros and Files (i.e., Text, Video, Sound, Auto)

n Verify that all resources are compressed. 

Do the following in the Designer:

1. Open your Demo in the Designer

2. Select Resource Manager under the Demo menu

3. Select the Images tab

4. Select each resource name from the listbox

5. Verify that the Compressed option is enabled for each resource

6. Repeat steps 2 through 4 for each type of resource contained within the demo

n Build Distribution disks without using the Setup Wizard.    As a last resort you can save about 
240K of space on your distribution disks by not using the Setup Wizard.    The disadvantages are:

No Program Group will be created. You will need to include directions on how to launch the demo. 

No unInstallShield support.    unInstallShield allows installed files to be removed.    Since the files 
are copied manually or run from a floppy unInstallShield will not be available.

The files needed on your distribution disk are:

DEMO.EXE
DS.DLL
[FILENAME.DBD]



AVI and SCM files (if Import Video Files By Reference is enabled in the Resource Manager)

EXE and support files (if using an Application Object and Import Application File has been 
enabled)

All of these files should be copied into the same directory.

To simplify the launch of your demo, you could name the *.DBD file DEMO.DBD.    The 
DemoShield Player (DEMO.EXE)searches for DEMO.DBD by default when it is executed.



How Can I Convert Slides From PowerPoint?

This article gives specific instructions for converting PowerPoint slides to graphics that you can present 
in DemoShield.    Note that the same general steps can be followed to convert slides from Freelance or 
other presentation programs. 

To convert the presentation, you must first save each slide as an Aldus placeable Windows Metafile 
(WMF).    In PowerPoint, select Save As under the File menu.    Enable the 'Embed True Type Fonts' in 
the Save As dialog.    This will cause the WMF to contain a pointer to the original font so that when the WMF is 
resized, the text will retain its clarity.    Once each frame has been exported, it is recommended that you 
convert the WMF to BMP using a graphics program such as Paint Shop Pro from JASC, Inc..    This is 
due to the fact that DemoShield does not use the palette information contained in a WMF.    Thus, 
colors may appear incorrectly when WMF images are used. 

Note          The current bit depth will be used to determine the bit depth of the WMF.    For example, if 
you are running Windows at 256 colors, the WMF will be 256 colors.

When opening the image in a graphics program, you may be prompted for the dimensions of the image.    Enter 
the dimensions    that you wish the image to have    in your demo.    You may also want to reduce the number of 
colors used    by your image.    This is especially true for users running Windows at True Color since any system 
running Windows at less than true color will display the images poorly.

Tip          If the WMF was created when running Windows in True Color mode and then later opened up 
in a graphics program when Windows is running in less than True Color, it may be interpreted as a 16 
-color image.    Thus, it is important to perform operations on the image in the same bit depth that was 
used when the WMF files were first generated

The are two ways to create the demo.    (1) You can display each slide in a new scene.    (2) You can 
display each slide in a separate Graphic Object and use effects to transition from one slide to the next 
within the same scene.

The first way is faster and easier to implement; the second way allows you to use effects such as fade-
outs.    I will outline both methods briefly here.

Scene Technique

1. Launch DemoShield

2. Create a new One Scene demo or open an existing one

3. Choose Properties from the Scene menu

4. Click the Fill Styles tab-select the Image radio button

5. Click the Import button-browse for the first slide of your demo

6. Click OK

7. Select New Scene from the Scene menu

8. Choose the Blank Scene style

9. Select Next Scene under the Control menu

10. Repeat steps 9 through 13 for all slides

11. Provide a means of navigation through the scenes (e.g., a VCR Object)

Graphic Object Technique

1. Launch DemoShield

2. Create a new demo- or open an existing one

3. Create a Graphic Object from the Auto Shapes palette and size it as necessary



4. Open the Properties dialog box for the Graphic Object

5. Select the Fill Styles tab- choose the Image radio button

6. Click the Import button-browse for the first slide of your demo

7. Select the Life tab

8. Enter the time you would like the slide to disappear in the Exit edit field

9. Enter the time you would like a fade to appear in the End edit field (recommended 2 seconds 
before the Exit time)

10. Select the End radio button

11. Choose Random Bits Disappearing in the Effect combo box

12. Repeat steps 3 through 11.    However, add additional seconds to the Exit and End times of each 
successive object (e.g., Object 1: End time 3, Exit time 5.    Object 2: End time 8, Exit time 10. 
Object 4: End time 13, Exit time 15, etc.)

13. Re-order the layering of the Graphic Objects as necessary

Tip          The Scene Editor can be used to quickly modify the layering of objects.    Click the ''View by 
Layer' button on the Scene Editor and use the Up and Down arrows to re-order the layering.    The last 
object listed will be the object on 'top' and the first object listed in the one furthest back.

See Also

Capturing Images



ScreenCam Tips

n Create your ScreenCam (.SCM) movies under 640x480 resolution.    This ensures that theyll play 
correctly under all resolutions. 

n Run Windows using a 16-color driver (e.g. VGA).    The resulting .SCM file will be smaller and will 
display properly regardless of the number of colors that your viewer is using.    Consult your 
Windows documentation for information on changing the screen resolution.

n When creating your Play Video action, enter placement coordinates of 0,0.    Your .SCM will 
appear be fully visible regardless of the screen resolution your viewer is running (provided you 
recorded the .SCM at 640x480).    If your demo is full screen the .SCM will play in the upper left 
corner of the screen.    If the demo is a centered window the .SCM will play directly on top of the 
demo window. 

n Remove the Keep Demo Always on Top option in the Demo Properties.    Failing to do so can 
result in your demo window appearing on top of the SCM during playback.

n When recording a ScreenCam video with captions, drag your captions into their desired positions 
when creating them.    When you save the caption file, the caption positions will be saved.    Then, 
at video recording time, your captions will appear in those respective positions, providing the look 
you need.

n When previewing a demo containing a ScreenCam movie verify that the ScreenCam Player 
(SCPLAYER.EXE) is in the same directory as the DemoShield Player (DEMO.EXE).    Otherwise, 
the .SCM will not play.

n When building your distribution disks using the Setup Wizard verify that the Lotus ScreenCam 
Player checkbox is enabled in Step 1.    Without the ScreenCam player the .SCM files will not 
play.



ScreenCam Instructions

ScreenCam is a program made by Lotus that allows you to create full screen recordings of your 
running applications.    ScreenCam recordings can be saved as either stand alone EXEs or as .SCM 
(ScreenCam Movie) files.    DemoShield allows for integrated .SCM playback.

Note          There are separate versions of ScreenCam for Windows 95 and Windows 3.1.    You must 
use the appropriate version to create a ScreenCam recording.

ScreenCam offers on-line help which describes the use of the product.    By following their directions, 
you may create video files which include captions and other effects.

Advantages

n Lotus ScreenCam generates video files that offer 1) relatively small file size, 2) smooth animation 
of cursors and other moving objects, and 3) visual playback of drag-and-drop characteristics 
within an application

n A single demo disk can hold the DemoShield run-time engine, setup utility, ScreenCam Player, 
and a demo containing many ScreenCam files

n Recording of video files is relatively simple and brief

Disadvantages

n While a ScreenCam video is playing, user interaction within the Demo is temporarily suspended

n ScreenCam lacks any editing capabilities

Steps

1. Create a ScreenCam recording.    Consult the ScreenCam on-line help for information on using 
ScreenCam

2. Launch DemoShield

3. Open an existing demo or create a new one, as desired

4. Select Resource Manager under the Demo menu

5. Select the Video tab

6. Click on the Import button

7. Click the List Files of Type combo box to the ScreenCam Movie option

8. Browse for the .SCM file created in Step 1 above

Note          If Import By Reference is enabled, you will need to copy the .SCM file into the same 
directory as the DemoShield Player.    Also, you will need to include the .SCM file with your demo when 
using the Setup Wizard.

9. Click the Close button

Tip          It is strongly recommended that you remove the Keep Demo Always on Top option on the 
Demo Properties.    Failing to do so can result in your demo window appearing on top of the SCM 
during playback.

10. Create an Event Object

11. Open the Event Object properties dialog box by double clicking on the Event Object

12. Select the Time tab-enter the time that you wish the ScreenCam movie to play

13. Select the True Actions tab

14. Click the New Action button



15. Select Play Video as the action to perform

16. Select the .SCM file imported in Step 8 above as the Video to Play

17. Enter the x, y coordinates for the desired position of the movie    playback

Note          ScreenCam movies are full screen recordings.    If you want your demo to be viewable on 
640x480 displays,    you will need to enter 0, 0 as the x, y coordinates.    Otherwise, part of the .SCM 
will not be visible.

18. Click OK

19. Select Save from the File menu

20. Preview the demo using the DemoShield Player (see below)

Note          The ScreenCam Player (SCPLAYER.EXE) needs to be in the same directory as the 
DemoShield Player (DEMO.EXE or DEMO32.EXE) in order to preview the demo.

See Also

AVI Support
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Import By Reference

Previewing a Demo

ScreenCam Tips



Windows 95/NT 4 Questions

Is there a Windows 95/NT4 version of DemoShield?

Yes.    There are two versions of DemoShield: a Windows Windows for Workgroups (WfW) 3.1x version 
(16 bit) and a combined Windows/WfW 3.1x and Windows 95/Windows NT (16/32 bit) version.    Both 
versions are designed to use the exact same interface and provide the same functionality.    However, 
the 32 bit version is designed to take advantage of the new capabilities available under 32 bit operating 
systems.    These include an additional action (View Internet URL) and Internet Save support. 

Does DemoShield run under Windows 95/NT4?

Yes.    The demo files (DBD) produced by a 16 bit version of DemoShield will operate normally under a 
32 bit operating system.    Functionality specific to the 32 bit version (e.g., View Internet URL) will be 
ignored by the 16 bit version.    However, there are two restrictions between demos created under 16 bit 
or 32 bit operating systems.    The restrictions involve live application demos (a demo that launches and 
controls another executable) and macros (a recording of mouse moves and key presses).    Due to the 
difference in the way that applications are handled under 32 bit operating systems, it is not possible to 
guarantee the reliability of a 16 bit live application demo under a 32 bit operating system.      The same 
restriction holds true for macros.    The data structure used by 32 bit macros is different than that used 
by 16 bit ones.    Thus, macros may not play back correctly. Taking these two limitations into 
consideration can help you produce a demo that will be playable under both 32 bit and 16 bit operating 
systems.    See Creating Cross Platform Live Application Demos for additional information.

Which version of DemoShield should I use?

If you will be developing demos that are to be distributed exclusively under 32 bit operating systems, 
then you should use the 32 bit version of DemoShield.    When developing demos to distribute to users 
of either 16 bit or 32 bit operating systems you may use either version of DemoShield to create your 
demo.    The 32 bit version of DemoShield includes a cross platform Setup Wizard.    This special 
version of the Setup Wizard can be used to create distribution disks that auto-detect the operating 
system and install the needed version of the DemoShield Player.

Can I use a demo that I created under the 16 bit version of DemoShield with the 32 bit 
version of DemoShield?

Yes.    DemoShield creates a DBD file that may be used by either the 16 bit or 32 bit version.    Thus 
both versions of DemoShield can read and write to the same DBD file.    If you began working under 
one version of DemoShield and realize that you really should be using another, there is no cause for 
concern.    Contact your DemoShield sales representative within 60 days of purchase to obtain the 
correct version of DemoShield.    Once you have the desired version, open your DBD in the Designer 
and perform a save.    This will update the DBD to the latest format, if necessary.



Improving the Performance of Your Demo

n Image resources take up memory.    It is advisable that you use the tips found in the Reducing the 
Size of Your Demo article.

n Purge any unused resources.    Do the following:

Do the following in the Designer:

1. Open your Demo in the Designer

2. Select Resource Manager from the Demo menu

3. Choose the Images tab

4. Press the Check button. Resources will in use will appear with a check mark next to 
it. 

5. Select an unused images from the listbox and delete them using the Remove button

6. Repeat steps 4and 5 for each type of resource contained within the demo (i.e. Text, 
Macros, Files, Video, Sound, Auto)

n Set the Demo Properties so that the demo runs in a fixed size window.    See Windowed Mode 
Demos for additional information.

n When using Graphic Objects to display Image resources remove any border style that may have 
been applied.    It takes longer to draw an image with a border than it does to draw an image with 
our a border.

n Hide Objects that do not need to be visible.

n Set the Exit time of object's so that they do not exist beyond their actual usage.



Creating Cross Platform Live Application Demos

A cross platform live application demo is a demo that launches and controls an external Windows 3.1 
(16 bit) application running under Window 3.1 or Windows 95/NT (32 bit).

By following the suggestions in this article, you will be able to evaluate the feasibility of creating a cross 
platform live application demo with your Windows 3.1 executable.

Critical Information

When setting the properties for your application object, it is necessary that you provide the Windows 
Class Name and/or Windows Caption in the Options tab to ensure that DemoShield can locate your 
running executable.    This information can be determined via programmer's utilities such as Microsoft's 
Spy or Borland's Winsight.    It is crucial that you enter the information exactly as it is indicated by the 
utility. 

Record Macros under Windows 3.1

The data structure of macros is different between 16 bit and 32 bit operating systems.    Thus, if you 
intend to use macros in a cross platform demo, it is necessary that you record the macros under 
Windows 3.1.

Use the Windows 3.1 Version of DemoShield

The Windows 3.1 version of DemoShield should be used along with the 16 bit version of your 
application.    Using the 32 bit version of DemoShield will produce unreliable results with a 16 bit 
executable and will create macros that are unusable under a 16 bit operating system.

Testing

Produce a test demo before committing to the development of a cross platform live application demo.    
You may encounter difficulties that you have not addressed if you create a live application demo 
assuming that it will run under both 16 bit and 32 bit operating systems.    Cross platform live 
application demos must be handled on a case by case basis.    One application may work without 
problems, whereas another will simply not operate as desired.    Testing will make you aware of any 
potential problems.



Product Demo

Purpose of Demo

This Product Demo serves as a mock sales demo for a fictional color laser printer: the X-15.    It is the 
type of demo that would be distributed to potential purchasers of this printer, outlining features and 
benefits of its use.

Techniques

The product demo begins with an attention-getting scene.    This includes a custom-made graphic 
image of a street and newspaper.    A brief, exciting musical piece is played simultaneously.

In the Menu scene, a small slide show loops continuously.    Here, five different images advertise 
features of the fictional X-15 printer.    As each image fades away, the next one fades in.

In the technical specs scene, an .AVI file is played to demonstrate animation capability.    For additional 
information regarding this file, refer to the Helper Applications Used for Demos article.

Advantages

n Usage of multimedia in a demo increases the end user's interest

n Usage of multimedia increases the user-friendly aspect of computer software

Disadvantages

n Sound (.WAV) and animation/video (.AVI) files require massive amounts of disk storage space.    
This requires most large-scale multimedia products (i.e., multimedia encyclopedias) to be 
distributed on CD-ROM

Steps

Use the following steps to create a fading slide show effect, assuming five (5) different images:

1. Import all five bitmaps or metafile images

2. Place them so that they physically overlap

3. Name each file in sequence of play, such as G 01 Billboard, G 02 Billboard, G 03 Billboard, etc..

4. Edit the properties of the first image.    Under the Life tab, set Start=0.0,    Hold=0.0, End=4.0, 
Exit=6.0.    In the Life Periods area, choose End and select Random Pattern Disappearing.    
Hit OK

5. Edit the properties of the second image.    Under the Life tab, set Start=4.0,    Hold=6.0, 
End=10.0, Exit=12.0.    In the Life Periods area, choose End and select Random Pattern 
Disappearing.    Hit OK

6. Edit the properties of the third image.    Under the Life tab, set Start=10.0,  Hold=12.0, End=16.0, 
Exit=18.0.    In the Life Periods area, choose End and select Random Pattern Disappearing.    
Hit OK

7. Edit the properties of the fourth image.    Under the Life tab, set Start=16.0,  Hold=18.0, 
End=22.0, Exit=24.0.    In the Life Periods area, choose End and select Random Pattern 
Disappearing.    Hit OK

8. Edit the properties of the fifth image.    Under the Life tab, set Start=22.0,  Hold=24.0, End=28.0, 
Exit=30.0.    In the Life Periods area, choose End and select Random Pattern Disappearing.    
Hit OK

9. Copy the first object and paste it into the scene to create a sixth image

10. Edit the properties of the sixth image.    Under the Life tab, set Start=28.0,    Hold=30.0, 
End=30.0, Exit=30.0.    In the Life Periods area, choose End and select Show.    Hit OK



11. Edit the scene properties and make the scene length 30 seconds.    Choose a scene transition of 
Replay Current Scene and hit OK

Use the following steps to import .AVI and .WAV files in your demo:

1. Choose Resource Manager from the Demo menu

2. Under the Video tab, click Import.    Select your video files and click OK

3. Under the Sound tab, click Import.    Select your sound files and click OK

4. Click Close

Use the following steps to use .AVI and .WAV files interactively in your demo:

1. Create a Button Object or Hot Spot Object.

2. Edit the button or hot spots properties.    Under the Actions tab, program an action that will Play 
<sound file> or will Play <video file>

Use the following steps to use .AVI and .WAV files automatically in your demo:

1. Create an Event Object

2. Under the Time tab, set the time that you wish your sound or video to play automatically

3. Under the Comparison tab, verify that the screen reads If this object/variable... ALWAYS

4. Under the True Actions tab, program an action that will Play <sound file> or will Play <video file>



Converting Quick Time video into AVI

Quick Time is the video standard created by Apple Computer, Inc..    Files in the Quick Time format 
must be converted into AVI format before they can be used with DemoShield.    To convert the files, you 
will need to download a utility from Microsoft's FTP site.    Note, this program is designed to be used on 
a computer running the Mac OS.    Do the following:

1. Establish an FTP connection to ftp.microsoft.com

2. Change directories to /developr/drg/Multimedia/Jumpstart/VfW11-Mac

3. Download vfw11.sit



Launch Application Action

Description

The Launch Application action allows you to launch a program or open another demo. 

Steps

To configure the Launch Application action do the following:

1. Create an object capable of triggering Actions (e.g., Button object)

2. Open the properties dialog of the object

3. Choose the tab that contains the actions to be triggered (e.g., Actions).

4. Click the New Actions button

5. Choose the Launch Application action

6. Enter the name of the desired application.    Click Next

Note        You can use a relative path if you wish.    This means that the executable can be located in a 
directory other than the one containing the Player.    To use relative paths, add the path token '<path>' 
before and after the name of the executable.    Also include the directory where the executable is 
located.    For example, if you wanted to launch MYAPP.EXE located in 
PROGRAM\COMPANY\PRODUCT\PROGRAM and the demo was in 
PROGRAM\COMPANY\PRODUCT\SAMPLE you would enter '<path>..
\PROGRAM\MYAPP.EXE'<path>

7. Enter any desired command line parameters.    Click Next

Hint        A command line parameter is an option used when launching an application.    For example, 
the Notepad accessory (NOTEPAD.EXE ) included with Windows can open a text file when a filename 
is used as the command line parameter.

8. Choose Wait for Application Termination if you want    the scene time to stop while the 
application is running.    Click Finished

Hint          You may wish to create a separate object to trigger a Pause/Continue demo action prior to the 
triggering of the Launch Application action.    This is because some applications will not run well if the 
DemoShield Player is running while scene time is advancing.    When scene time is advancing the 
DemoShield Player, will take clock cycles away from your application.

Advanced Tips

You can configure the Launch Application action to use data entered in an Edit Field object in place of 
an application name or command line parameter.    This may be useful if you wish the user to enter the 
name of a file to open along with the application.    Or perhaps you want the user to type in the location 
of a program to launch.    To do so you will need to create an Edit Field object to accept the data and, 
when creating the Launch Application action, you will need to use the Edit Field token <[NAME OF 
EDIT FIELD OBJECT]>. 

Steps

We will create a sample scene that takes data entered in an Edit Field object and uses it to determine 
what TXT file to open.

1. Create an Event object (e.g., Event 1)

2. Open the Event object properties dialog

3. Choose the True Actions tab

4. Click the New Actions button



5. Choose the Pause/Continue Demo action.    Click Finish.    Click OK

6. Create an Edit Field object (e.g., Edit Field 1)

7. Create an a Button object (e.g., Button 1)

8. Open the Button object's properties dialog

9. Choose the Object Styles tab

10. Verify that the Style selected is Push Button

11. Enter the desired caption for the button in the Button Caption edit field

12. Choose the Actions tab

13. Click the New Actions button

14. Choose the Pause/Continue Demo action.    Click Finish.    Click OK

15. Create an Event object

16. Open the Event object properties dialog

17. Choose the Time tab.    Enter 0.1 seconds in the start time edit field

18. Choose the True Actions tab

19. Click the New Actions button

20. Choose the Launch Application action

21. Enter NOTEPAD.EXE as the name of the application. Click Next

22. Enter the name of the Edit Field object as the command line parameter (e.g., <Edit Field 1>). 
Click Next

23. Choose Wait for Application Termination if you want    the scene time to stop while the 
application is running.    Click Finished

Note          The value entered in the Edit Field must be a valid text file in order for Notepad to open it.

24. Preview the demo through the DemoShield Player

See Also

Previewing a Demo



How DemoShield Handles Colors

This article is intended to give you a basic understanding of how DemoShield handles color when using 
Bitmap (BMP) or Windows Metafile (WMF) images.    Any image used in DemoShield in BMP or WMF 
format can be classified as either a 16-color image, a 256-color image, or a high-color or true-color 
image. These classifications are described below:

n 16-Color - Images that contain 16 colors use one of two color palettes: a Windows palette or an 
Optimized palette.    An image using the Windows palette will use the 16 standard colors that are 
used by the Windows environment to display the image.    An image using an Optimized palette, 
on the other hand, will contain the best 16 colors for displaying the image.

n 256-Color - Images that contain 256 colors are utilized in DemoShield with a 256 standard color 
palette.    This means that DemoShield will generate a color palette with up to 236 entries for an 
image.    The remaining 20 entries are reserved for system colors (16 Windows standard colors + 
4 Windows defined colors).

n High-Color or True-Color - Images that are High-Color or True-Color have excellent image quality 
and may contain over 65,000 colors to display the image.

When including images in your demo, it is important to remember that the more colors an image 
contains, the larger the image size will be.    This may affect the performance and size of your demo, 
especially for floppy disk or internet distribution. 

DemoShield can generate a color palette with up to 236 entries when Windows is running under a 256-
color setting.    In order for DemoShield to use this standard 256-color palette, you need to enable Allow 
Palettized Colors under Demo|Properties|Options tab.    This color palette is generated using the colors 
from the scene background and all objects in the scene currently being displayed.    The palette entries 
generated for one scene will be carried over into the next scene by default unless you select Enable 
Full Palette Display in the Scene|Properties|General tab.    Therefore, as long as the total number of 
unique palette entries between any two consecutive scenes is less than 236, all images and objects will 
display using the colors youve assigned.    If this limit is exceeded, however, the colors will map to the 
closest available color in the currently realized palette.

Hint          You can check the number of colors used in a scene by displaying the General tab of the 
Scene Properties dialog. 

What has changed?

Earlier versions of DemoShield differ from DemoShield5.1 in two critical ways:

n The Scene background now gets top priority when allocating palette entries.

Earlier versions of DemoShield gave the scene background lowest priority when allocating palette 
entries.    If there were not enough palette entries for the scene background to realize all its 
colors, the scene background would receive none of its entries.    Instead, it would map to a 16 
color Windows palette.

n Palette entries are shared between scenes by default. 

Earlier versions of DemoShield realized a color palette on a scene by scene basis.    This would 
cause a flash to appear as the old palette used by one scene was discarded and    replaced by 
the new palette to be used in the next scene.

Note          You may still force DemoShield to realize a color palette for a particular scene by selecting 
Enable Full Palette Display in the Scene|Properties|General tab.    This would be desirable only 
when a scene needs palette entries that are unique from the previous scene's palette, and there is 
aninsufficient number of entries available.

Whats has not changed?

The following restrictions on palette allocation still exist in DemoShield5.1:



n AppCam resources do not receive palette entries.

AppCam resources are displayed using a standard Windows palette.    Therefore, it is 
recommended    that you run Windows in 16-color mode when creating an AppCam resource.

n Windows metafiles (WMF) containing a palette do not receive palette entries.

Some programs create WMF images with color palette information.    DemoShield will not use this 
palette when displaying the WMF. If palette entries are needed, it is suggested that you convert 
WMF files to BMP format before    using them    in your demo.      A graphics program will be 
needed to perform the conversion.

Tips

For the most part, the default sharing of palette entries between scenes should work quite well.    
However, you may want to keep the following things in mind when creating your images:

n Try to keep the number of colors used in each scene to less than 118.

If the number of palette entries used in any scene in your demo never exceeds 118, you can be 
sure that the number of palette entries between scenes will not exceed 236.    This ensures the 
best possible display of images.    Graphics programs such as Paint Shop Pro from JASC, Inc., 
can be used to dither images to a specific number of colors.    You may wish to dither all images in 
a scene to a color palette (.PAL) that best represents all the images used in the scene. 

n Test run the demo on a 256-color system.

Test the demo on a 256-color system before    distributing it .    This will help you detect any 
potential color problems    before it is too late to correct them.

n Create a 236-color palette (.PAL) and dither images to it.

Power users may wish to create a 236-color palette that best represents the images used in the 
entire demo, and dither images to it. Since all images use the same palette, this ensures that your 
bitmaps will not    exceed 236 colors. 

Note          Your text objects, graphic objects, button objects, etc., will need to use colors from the 
customized palette or from the standard Windows palette.    Otherwise you will exceed 236 colors.

n Select Enable Full Palette Display only when absolutely necessary.

When the images used in your demo require    a 236-color palette that is unique between scenes, 
you should select Enable Full Palette Display.    This should be true only for    graphically rich 
images such as digitized photo or sophisticated 3-D rendered graphics.    Most images can be 
dithered to fewer colors with a minimal decrease    in quality.    Remember, the user of a 256-color 
Windows system will see a flash when DemoShield is forced to discard a previous scene's palette 
to generate a new one.



AppCam FAQ

Q: Do I need to position my application exactly within the dimensions of the sizing guide?

A: No.    The sizing guide is merely a reference point to help you capture a base window that fits within 
the dimensions of your demo.

Q: Why does my AppCam look too small?

A: An AppCam is composed of a series of images displayed upon a base image.    If your AppCam 
appears to be too small, you captured the wrong window as the base window.    When capturing the 
base window, be sure to click on the Title bar of your application.

Q: When I preview my AppCam, it looks jumpy.    Will it play like that from my demo?

A: No.    The preview dialog is merely a rough draft of the AppCam.    During    demo playback, the 
images will be cached for optimal display.

Q: During certain parts of my AppCam playback, part of the image disappears and only the 
button/menu I captured is shown.    Can I fix this?

A: Yes.    Image elements are displayed on top of the first element in a sequence.    Merge two 
sequences to use an earlier sequences image element as the base window.

Q: The colors don't look right in my AppCam.    Why?

A: DemoShield does not realize a color palette for an AppCam.    For the best results, run Windows in 
16 color mode.

Q: Will an AppCam I have created under one version of Microsoft Windows play under another?

A: Yes.    An AppCam can be played back under any version of Microsoft Windows.

Q: Can other objects be placed on top of an Automation Object?

A: Yes.    The Automation Object displays according to its layer.    To move an Automation Object 
forward or backward, select the object and choose the desired option from the Object menu. 

Q: Can a WAV file be played during an AppCam?

A: Yes.    You are free to use the Play Sound action, or any other action during AppCam playback.

See Also

AppCam Tips & Tricks



AppCam Tips & Tricks

n Record an AppCam Sequence when running Windows in VGA (640x480 16 color) mode.    This 
will keep this size of the file small and help ensure that users of any system can view the 
AppCam.

n To lengthen the duration of a Cursor Move, drag the element over to the left.    The duration of a 
Cursor Move is determined by the distance from the Cursor element and the next element in the 
sequence.

n To extend the duration of an AppCam, drag the end of the last sequence to the right to the 
desired duration.

n Always keep the size of your base window consistent between separate recording sessions of an 
AppCam.    This will give your demo a consistent look and feel.

n Use the Size option under the System menu to assist in sizing your application window.    The 
System menu is the menu that is displayed when you click on the upper right corner of a window. 
Under Windows 95 this can be particularly useful, as the Task Bar can be resized and 
repositioned along with the Size option to get a consistent size.    To use the Size option along 
with the Task Bar, do the following:

1. Change to the desired resolution.

2. Reposition the Task Bar by clicking on it and dragging it to the top or bottom of the screen.

3. Resize the Task Bar in the same way you would resize a Window.    Note how the Task Bar will 
only increase in steps.

4. Launch your application.

5. Click in the upper left corner to display the System menu.

6. Choose Size from the System menu.

7. Press the down arrow key on your keyboard.    The cursor will change to the NS Pointer.

8. Drag the cursor down on the screen using the mouse.    The Window will not extend beyond the 
Task Bar.

9. Drag the Task Bar to the right or left side of the screen.

10. Repeat steps 6 through 8 to change the width of the window.

Note          All    AppCams created for the Quick Tour demo use this technique.

See Also

AppCam FAQ



Lotus Technical Support

For support on products bundled with DemoShield, such as ScreenCam, you will need to contact the 
software vendor directly.    As a service to users of DemoShield, a description of Lotus Corporate 
Desktop Support Services is included here.

Lotus Corporate Desktop Support Services

Lotus Development Corporation provides software products and support services that meet the 
evolving technology and business application requirements for individuals, work groups, and entire 
organizations.    The Lotus support offerings range from complimentary automated support services to 
premium telephone support offerings for corporations with many choices in between. 

Individual Support Membership

An Individual Support Membership is designed specifically for individuals or companies with one to five 
users of our products.    An Individual Membership must be purchased for each user of the service.    
The annual fee is your only cost.    Once you join, youll be given a special toll-free number which gives 
you priority access to our specialists.

5x12 Business Hour Service

Priced at $179 annually per user, membership provides you with priority support for all desktop 
products between the hours of 8:00 a.m. - 8:00 p.m. (Eastern) Monday - Friday

Corporate End-User Telephone Support for Desktop Products

The Corporate End-User contracts provides access to Lotus Technical Support Specialists for end 
users of desktop products, at a discount based on a sliding scale dependent on the number of users to 
be using this service.    Lotus Desktop products include 1-2-3, Ami Pro, Approach, Freelance Graphics, 
Organizer (PIM), SmartPics, ScreenCam, and SmarText.    Support is available 24 hours a day, 7 days 
a week for 1-2-3, Ami Pro, Approach, Freelance Graphics, and Organizer (PIM).    All corporate support 
offerings are annual contracts with 60-day money back guarantees.

Additionally all corporate programs include toll-free access to the award winning automated services 
which include Lotus Fax, Bulletin Board and CompuServe services.    These services provide direct 
access to thousands of documents on Lotus products 24 hours a day, 7 days a week.

Suggested Retail Price for this program is a sliding scale based on the number of users using this 
service during the contract period:

      6----24 users $          995

    25---99 users $    2,995

100---499 users $    7,495

500---999 users $12,495

1000 plus users $12.50 per user

900# Telephone Support (U.S. Only)

For those customers who prefer to pay-as-you-go for support, this option utilizes the 900-555 exchange 
designated only for business-to-business use.    When you call, you will speak to a professional Lotus 
Technical Support Specialist who is trained to work with you to solve your questions as they arise.

The cost is $2.95 per minute, and there is a $50 cap per call.    Billing starts when you are connected to 
a technical support specialist.    This charge will appear on your monthly telephone bill.    Hours are 8:00 
a.m. - 8:00 p.m. (Eastern), Monday-Friday.

To access this service, call (900) 55-LOTUS {(900) 555-6887}.

Pay-per-Incident Support



This service allow customers to pay-as-you-go for support services.    For a flat fee of $35, you will be 
connected with a highly trained Lotus technical support specialist who will work with you on your 
question.    Please note that an incident is one or more calls needed to solve one problem.

In the U.S., call (800) 553-4270 from 8:00 a.m. - 8:00 p.m. (Eastern), Monday-Friday.

In Canada, call (416) 364-5667 from 8:30 a.m. - 8:00 p.m. (Eastern), Monday-Friday.

Automated Support Services for Desktop Products

Lotus provides complimentary assistance for anyone with a touch tone phone, 24 hours a day, seven 
days a week through the Lotus Automated Support Center.    Information is available through Lotus Fax 
and the Lotus Bulletin Board with additional services available through CompuServe.

Lotus FAX

Through the Lotus Fax service customers have access to thousands of documents on Lotus 
products.    It is the same information Lotus Customer Support Specialists use and it enables the 
user to access technical documents and troubleshoot potential problems.    Customers can 
choose to have documents faxed to them or request a catalog of available documents.    Each 
catalog contains document titles, brief abstracts, and document order numbers for a reference 
library of customer support notes, application tips, and performance enhancement techniques.    
You may order documents by the appropriate number from any touch-tone telephone and have 
them delivered to any fax machine world-wide.

Bulletin Board Services (Modem Access)

Lotus offers a modem-based option to our automated services that provides dial-in access to 
Lotus CD/PROMPT, a CD-ROM based library of over 30,000 Lotus product technical notes, 
documentation, and publications.    This service enables customers to perform on-line searches 
for productivity techniques, sample applications, and troubleshooting tips.    Callers may access 
CD/PROMPT from their desktop through any VT-100 compatible terminal emulation program or 
by downloading Novells OnLan remote dial-in utility.

CompuServe

The Lotus Forums on CompuServe provide answers to technical questions, allow the exchange 
of ideas with thousands of other users, or post the latest product information and updates.    Users 
can communicate on-line with Lotus Technical Support and other users on the forums electronic 
message board.    Users can browse the product libraries or download the latest product 
information, technical bulletins, product updates, demonstration programs, and application 
templates.

All our support services are designed to ensure that we fulfill the mission stated in our service and 
support strategy, to view our relationships as partnerships dedicated to helping our partners discover 
and achieve maximum value from our products and services.    Please call (800) 553-4270 for further 
information.    Prices and terms of support services are subject to change.

⌐ 1996 Lotus Development Corporation



Presales Demo

The purpose of the Presales demo is to demonstrate DemoShield's functionality and interest potential 
users into purchasing DemoShield.    Navigation is handled via Hot Spots and buttons.    The topics 
covered include the Design Environment and Wizards sections.    Also included is the Contact 
Information and Special Offer sections (discusses products bundled with DemoShield).

Techniques

The content for this demo is based upon the DemoShield5 brochure.    The topics and copy (i.e. text 
describing different features) was derived from the brochure as well.    After planning the content, a 
team met and planned the interface.    We produced a story board to help us develop the needed 
graphics and integrate all the content with DemoShield. 

We created graphics using: Picture Publisher, PhotoShop, Raydream Designer, and Macromedia Freehand.    
The number of colors used by the bitmaps was reduced using JASC, Inc.'s Paint Shop Pro.    Images 
were resized with WexTech Systems, Inc. Smooth Scaling. 

Sound effects were found on digital clip libraries distributed by CASCAM International, Inc. and 
Wayzata Technology.    Audio editing was done with Creative Studio's WAV Studio.

The following techniques were used in the various scenes:

ATTENTION GRABBER

A WAV file is played at zero seconds using an Event Object triggering a Play Sound action.    Three 
Rectangle Objects are used to provide an animation effect.    Their background is transparent and point 
to point motion is used to move the objects to the desired location on screen.    A 640x480 bitmap is 
used as the background.

WELCOME

A glow effect is generated when the viewer moves the mouse on top of a button.    This is done by 
performing a Show action on a Rectangle Object that displays the bitmap.    When the mouse is moved 
off of the button, the Rectangle Object is hidden.

MAIN MENU

Two Hot Spots are used to provide access to the demo main topics: Design Environment and Wizards. 
Supplementary information is accessed via Bitmap Buttons.    When the viewer moves the mouse on a 
Hot Spot, he is sent to a separate scene in which a series of images is displayed producing an 
animation effect. 

MENU DE ANIM

10 Rectangle Objects display several images for various lengths.    After 5.6 seconds, the scene loops. 
The duration that the images are visible is controlled via the Life Span.    By making the Life Span 
slightly different for the images, the scene can be looped without seeming repetitive.

MENU WIZARDS ANIM

6 Rectangle Objects are used to view several different images which fade out via the Random Pattern 
Disappearing Effect.    After 5.0 seconds, the scene loops.    This creates the effect of continual fading 
images until the viewer click one of the Hot Spots or Bitmap Buttons or the viewer moves the mouse 
over the Design Environment Hot Spot.

DESIGN ENVIRONMENT

Event Objects are used to trigger Move Cursor actions combined with Show actions demonstrating how 
to navigate the different topics in this scene.    Each topic has a Hot Spot on top of it.    When the Mouse 
is moved on the Hot Spot, an image is displayed showing the topic glowing.    A Text Object displaying 
the topic name is displayed as well.    When a Hot Spot is clicked, a Play Sound action is triggered, the 
demo is delayed until the sound is done playing, and the viewer is sent to a separate scene.



DE-[ALL]

A Rectangle Object is used to display the topic's graphic.    DemoShield Text Objects are used to 
explain the feature.    When clicking on the Back button, a WAV file is played.    This file is the same as 
the one played in the DESIGN ENVIRONMENT except that it has been reversed.

WIZARDS

An Event Object triggered at 0.1 second plays Pachelbel's Kanon in D.    Bitmap Buttons are used to 
provide access to the three sub topics.    When the mouse is moved on top of a button, the text 
changes color and when clicked upon, the viewer is sent to another scene.

WIZARDS - [ALL]

All related graphics, text, and buttons are organized into Group Objects.    This was done so that any 
changes to what the viewer sees can be performed with a minimal number of actions.    Group Objects 
allow Hide/Show and Enable/Disable actions to be performed upon all members of the group.    Also, it 
is easier to make changes to the demo later on when objects are organized in a group rather than by 
life span.

CONTACT INFO & SPECIAL OFFER

The Text Object displayed on top of the graphic has a shadow effect.    This has been done by 
duplicating the text, shifting it over one pixel on each axis, and changing the color.

EXIT

The animation effect used here is the same one used on the ATTENTION GRABBER scene.    
However, only one Rectangle Object is moved and a different WAV file is played.

Advantages

n A quick overview of DemoShield is provided in a manner that retains viewer interest

n Many of the graphics used are visually appealing

n The interface is easy to use

Disadvantages

n Creating custom images requires familiarity with graphics programs and graphic design skills

n The interface used in the Design Environment is somewhat difficult to implement

n Playback of the demo on 16 color systems will not display images correctly as all bitmaps are 256 
color

Steps

To display a bitmap do the following:

1. Create a Rectangle Object from the Auto Shapes palette.

2. Open the Rectangle Object properties dialog by double clicking on the object.

3. Select the Fill Styles tab.

4. Choose the desired image from the Images listbox.    If the image you wish to use is not listed, 
you may import it by clicking the Import Image... button.

5. Choose Resize Frame as the Image Option.

To play a WAV file do the following:

1. Select Resource Manager from the Demo menu.

2. Choose the Sound tab.

3. Enable Import by Reference if desired.



Note          When a resource is imported by reference, a zero byte pointer to an external resource is 
imported in place of the actual file.    In order for Import by Reference to operate properly, the resource 
that has been referenced must be in the current working directory.    The current working directory is the 
directory from which the Designer or Player is being launched from.

4. Click the Import button.

5. Locate the desired WAV file and press Import.

6. Create an Event Object.

Hint          Any object capable of triggering actions can be used to perform a Play Sound action.

7. Select the Time tab and enter the desired time you wish the WAV file to play.

8. Choose the True Actions tab.

9. Click the New Action button.

10. Choose Play Sound as the action to perform.

11. Select the desired sound to play.

To create an animation effect using one or more bitmaps do the following:

1. Select Resource Manager from the Demo menu.

2. Choose the Image tab.

3. Click the Import button.

4. Locate the desired BMP file and press Import.

5. Create a Rectangle Object from the Auto Shapes palette.

6. Open the properties of the Rectangle Object.

7. Choose the Fill Styles tab.

8. Choose Image as the Fill Style.    Select the desired image to display.

9. Choose Resize Frame as the Image Option.

10. Enable Transparent.

Note          The Transparent option is only available for 16 color BMPs.    If you are using a 256 color or 
greater BMP. you will need to dither it to 16 colors first.

11. Choose the Border Styles tab.    Select the desired border.    If none is desired click the box in the 
upper left hand corner.

12. Choose the Background Color tab.

13. Select the color in the bitmap you wish to have as transparent.

14. Choose the Life tab.

15. Select the Start Life Period.

16. Select the desired Motion or click the Capture button to set the location where the Rectangle 
Object will begin moving from.

To display an image of a button glowing when the mouse moves on top of it and hide the image when 
the mouse moves off of it, do the following:

1. Create a Rectangle Object using the steps above (e.g. G Glow in the Welcome scene).

2. Disable the Visible Property in the Rectangle Object's Properties | General tab | Initial State.

3. Create a Bitmap Button Object (e.g. B Next in the Welcome scene).

4. Open the Bitmap Button's properties.



5. Choose the Fill Styles tab.

6. Select Image as the Fill Style and choose the desired image.

7. Choose the Actions tab.

6. Click the New Action button.

7. When Mouse Moves On Object perform the Show action upon the desired object (e.g. G Glow) 
for Scene Duration.

8. When Mouse Moves Off Object perform the Hide action upon the desired object (e.g. G Glow) 
for Scene Duration.

9. When Left Clicks Mouse perform the desired action (e.g. Go to Scene).

10. Select the Rectangle Object and move it to the front by selecting Move Object to Front from the 
Object menu.

To create an animation effect where several images are displayed for various lengths (e.g. Menu DE 
Anim scene), do the following:

1. Import the desired images via the Resource Manager.

2. Create twice as many Rectangle Objects as there are images you wish to display.

3. Use the steps above to display the images via the Rectangle Objects.

4. Open the properties of first Rectangle Object (e.g. G DE-1 in the Menu DE Anim scene).

5. Choose the Life tab.

6. Enter the desired Life properties for Start, Hold, End, and Exit (e.g. G DE-1 uses 0.0, 0.2, 0.5, 
0.6).

7. Repeat steps four through six for all Rectangle Objects, however increase the time used for the 
life periods by 0.5 through 1.0 second (e.g. G DE-2 through D DE-10 in the Menu DE Anim 
scene).

8. Create an Event Object.

9. Open the properties of the Event Object.

10. Choose the Time tab.

11. Enter the time you wish the scene to loop.

12. Choose the True Actions tab.

13. Press the New Action button.

14. Choose Go to Scene as the action to perform and specify the current scene being viewed (e.g. E 
5.0 Replay scene triggers a Go to Scene DE    Anim action at 5.0 seconds).

To create an animation effect where one image fades into the next one (e.g. Menu Wizards Anim 
scene) do the following:

1. Import the desired images via the Resource Manager.

2. Create twice as many Rectangle Objects as there are images you wish to display.

3. Use the steps above to display the images via the Rectangle Objects.

4. Open the properties of first Rectangle Object (e.g. G Wand1 in the Menu Wizards Anim scene).

5. Choose the Life tab.

6. Enter the desired Life properties for Start, Hold, End, and Exit (e.g. G Wand1 uses 0.0, 0.5, 0.6, 
1.0).

7. Choose the End Life Period and choose Random Pattern Disappearing as the Effect.



8. Repeat steps four through six for all Rectangle Objects, however increase the time used for the 
end and exit periods by 1.0 second (e.g. G Wand1a uses 0.0, 1.5, 1.6, 2.0, G Wand2 uses 0.0, 
2.5, 2.6, 3.0, etc).

9. Create an Event Object.

10. Open the properties of the Event Object.

11. Choose the Time tab.

12. Enter the time you wish the scene to loop.

13. Choose the True Actions tab.

14. Press the New Action button.

15. Choose Go to Scene as the action to perform and specify the current scene being viewed (e.g. E 
5.0 Replay scene triggers a Go to Scene Wizards Anim action at 5.0 seconds).

16. Re-order the layering of the Rectangle Objects as necessary.

Tip          The Scene Editor can be used to quickly modify the layering of objects.    Click the View by 
Layer button on the Scene Editor and use the Up and Down arrows to re-order the layering.    The last 
object listed will be the object on 'top' and the first object listed in the one furthest back.

To create an image map that displays a bitmap of a glowing image for different topics (e.g. Design 
Environment scene) do the following:

1. Create bitmaps in a graphics program representing the topic when it is selected (e.g. in the 
Presales demo we show an image glowing) and when it is not selected.

Tip          Each topic which can be selected will require its own bitmap.    This is because the Hot Spot 
Object will be used to display the "selection".

2. Import the bitmaps via the Resource Manager.

3. Create one Rectangle Object for each image that has been created for the image map using the 
steps above (e.g. G Background, G Topic1 through G Topic5 in the Design Environment scene).

4. Disable the Visible Property for all Rectangle Object's except the background (properties | 
General tab | Initial State | de-select Visible).

5. Create one Hot Spot Object for every topic (e.g. HS Topic1 through HS Topic5 in the Design 
Environment Scene).

6. Open the Hot Spot Object's properties.

7. Choose the Actions tab.

8. Click the New Action button.

9. When Mouse Moves On Object, perform the Show action upon the desired object (e.g. G 
Topic1) for Scene Duration.

10. When Mouse Moves Off Object, perform the Hide action upon the desired object (e.g. G Menu 
Top) for Scene Duration.

11. Repeat steps five through eight for all Hot Spot objects created.

Hint          If desired, you may also create a Text Object to display a label representing the name of the 
topic when the viewer moves the mouse on top of the Hot Spot (e.g. T Label1 in Design Environment). 
You will need to add an additional Show/Hide action to the Hot Spot objects to display/hide the Text 
Object.

To change the color of the text on a button when the viewer moves the mouse on top of it (e.g. the 
Wizards scene) do the following:

1. Create a Bitmap Button object.



2. Open the Bitmap Button object's properties.

3. Choose the Object Styles tab.

4. Enter the desired caption for the button in the Button Caption editfield.

5. Choose the desired position for the caption from the Caption Position groupbox.

6. Choose the Actions tab.

7. When Mouse Moves On Object perform the Enable action upon the Bitmap Button object (e.g. 
B Topic1) for Scene Duration.

8. When Mouse Moves Off Object perform the Disable action upon the desired object (e.g. B 
Topic1) for Scene Duration.

9. When Left Clicks Mouse perform the desired action (e.g. Go to Scene).

To display a round image while cropping off the background (e.g. G Button1 in the Wizards scene) do 
the following:

1. Create a bitmap in a graphics program.

2. Import the bitmap using the Resource Manager.

3. Create a Circle Object from the Auto Shapes palette.

4. Open the Circle Object's properties.

5. Choose the Fill Styles tab.

6. Select Image as the fill style and choose the desired image from the Images listbox.

7. Select Crop Image as the Image Option.

8. Choose the Border Styles tab.

9. Select the box in the upper left hand corner to remove the border from the Circle Object.

10. Click OK.

11. Resize the Circle Object in the Design Window.

Hint          To decrease the dimensions of the Circle Object one pixel at a time use Shift+CURSOR 
KEYS.    To increase the dimensions of the Circle Object one pixel at a time use Ctrl+CURSOR KEYS.



CD Browser Demo

Purpose of Demo

A CD Broswer demo provides a visual front end to a CD ROM.    The CD Browser included as a sample 
demo is the same one used on the DemoShield5 CD.    Users are given the choice of installing 
DemoShield, learning about other products made by DemoShield Corporation, and obtaining contact 
information for Sales and Technical Support.

Techniques

The first step to planning this demo involved determining the content.    Once aware of the content we 
determined the structure.    We decided that allowing the viewer to view any topic from any other topic 
was desirable.    Thus, there is no 'Menu' scene. Instead buttons along the side of the scene are used to 
provide navigation throughout the demo.

The interface design was planned in a team consisting of a graphics artist and DemoShield developer. 
After agreeing on design, the graphic artist created the images (bitmaps) needed and the DemoShield 
developer created a prototype of the demo.    In a prototype of a demo "place holders" are used for 
resources that are not yet completed.    A place holder is sample text, graphics, or any other resource 
that is used to represent what and where the completed resource will be.    When the resources are 
finalized the place holder is replaced with the actual resource.    This allows for the demo and the 
graphics to be developed concurrently.

The following techniques were used in the various scenes:

WELCOME

The scene background uses an Image Fill Style to display the bitmap.    The areas of the bitmap that 
will be "hot" (i.e. interactive) are a part of the background.    To create the "glow" effect a separate 
image was created showing the image as it would appear when glowing.    When the mouse is moved 
on top of these areas a Hot Spot Object shows the "glowing" bitmap.    The glow is used to reflect that 
the area of the image is hot.

INSTALL

The ticket bitmaps are used to represent a button that can be clicked to install DemoShield.    To 
represent that the ticket is hot a Hot Spot Object is used reveal an image underneath of the ticket 
without a shadow.    This creates a 'pushed' effect.    To launch the installation the Hot Spot triggers a 
Launch Application/Demo action when clicked.

PRODUCT INFO

Next and back buttons are used to navigate information about the different products.    The product 
name, product description, navigation controls, and counter (e.g. '-1/3-') are grouped using the Group 
Object.    The Group Object allows Hide/Show and Enable/Disable actions to be performed upon all 
members of the group at one time.

Advantages

n A visual front end to CD is more "user-friendly" than launching an installation directly

n Allows for customers of one product to become familiar with other products in a companies line 
up

Disadvantages

n Creation of custom graphics, such as those used in the CD Browser, requires familiarity with 
graphics packages and graphic design ability

Steps

To display an image glowing when the mouse moves on a hot region of the scene do the following:



1. Create a Rectangle Object (e.g. G Install Glow in the Welcome scene).

2. Open the Rectangle Object properties dialog by double clicking on the object.

3. Select the Fill Styles tab.

4. Choose Image as the Fill Style

5. Choose the desired image from the Images listbox.    If the image you wish to use is not listed, 
you may import it by clicking the Import Image... button.

6. Choose Resize Frame as the Image Option.

7. Disable the Visible Property in the Rectangle Object's Properties | General tab | Initial State.

8. Create a Hot Spot Object (e.g. HS Topic1 in the Welcome scene).

9. Open the Hot Spot's properties.

10. Choose the Actions tab.

11. Click the New Action button.

12. When Mouse Moves On Object perform the Show action upon the desired object (e.g. G Install 
Glow) for Scene Duration.

13. When Mouse Moves Off Object perform the Hide action upon the desired object (e.g. G Install 
Glow) for Scene Duration.

14. When Left Clicks Mouse perform the desired action (e.g. Go to Scene Install).

15. Select the Rectangle Object and move it to the front by selecting Move Object to Front from the 
Object menu.

To create a 'pushed' effect using a bitmap that has a shadow on it (e.g. Install scene) do the following:

1. Create a Graphic Object to display the entire bitmap image using steps 1 through 4 above (e.g. G 
16 bit in the Install scene).

Hint          You may wish to use Crop Image as the Image Option to tweak the exact dimensions of the 
Graphic Object.    In the CD Browser demo we used Crop Image to crop part of the background out of 
the bitmap to get the image to look better when placed on top of the background.    Crop Image will 
center the bitmap within the Graphic Object and crop out the edges.    The cursor keys can be used 
along with the Shift or Control key to change the dimensions of the object along each axis pixel by 
pixel.

2. Create a Graphic Object to display the same bitmap as in step 1.    This time however, we are 
going to crop out the shadow on the image (e.g. G 16 bit pressed in the Install Scene).

3. Choose Standard as the Image Option.

Note          The Standard Image Option will place the image in the upper right hand corner of the 
Graphic Object.    If the size of the Graphic Object is reduced the image will be cropped.

4. Use Shift along with the cursor keys to crop out the shadow on the bitmap.

5. Create a Hot Spot Object to Hide the image with the shadow when the mouse moves on it (e.g. 
HS 16 bit)

6. Open the properties of the Hot Spot Object by double clicking on the object in the Design 
Window.

7. Choose the Actions tab.

8. Click the New Action button.

9. When Mouse Moves On Object perform the Hide action upon the desired object (e.g. G 16 bit) 
for Scene Duration.



10. When Mouse Moves Off Object perform the Show action upon the desired object (e.g. G 16 bit) 
for Scene Duration.

11. When Left Clicks Mouse perform the desired action (e.g. Launch Application/Demo).

To use the Group Object to all Hide/Show and Enable/Disable actions to be performed upon multiple 
objects (e.g. Product Info scene).

1. Create a Group Object (e.g. Gr Prod1 in the Product Info scene)

2. Open the Group Object properties by double clicking on the object

3. Enter the Name (e.g. Gr Prod1) and Group Name (e.g. 1) to be used.    The Group Name will be 
used for all other objects that are members of the group.

Hint          Come up with a naming scheme that can be used consistently in more then one scene.    This 
way you can create a scene to be used as a template for future scenes.    Also, if you need to alter the 
demo at some future time you will be able to easily familiarize yourself with how the demo was 
organized.

4. Create a Text Object - this object will be used to describe the product

5. Open the Text Object properties by double clicking on the object

6. Select the General tab

7. Enter the Name (e.g. T Desc1) and Group Name (e.g. 1) to be used.    Note, the Group Name 
needs to match the Group Name given to the Group Object

8. Verify that the Visible property is enabled.    Note, the visible property should only be enabled for 
objects you wish to have visible at the beginning of the scene.    Other objects will be made visible 
only when the user has clicked on the Next or Back button.

9. Select the Object Styles tab-enter the desired text

10. Create a Text Object-this object will be used for the product name

11. Open the Text Object properties by double clicking on the object

12. Select the General tab

13. Enter the Name (e.g. T Product1) and Group Name (e.g. 1) to be used.    Note, the Group Name 
needs to match the Group Name specified in the Group Object

14. Select the Object Styles tab-enter the desired text

15. Create a Text Object-this object will be used as a counter to indicate which product out of the total 
number of products described is currently being viewed

16. Open the Text Object properties by double clicking on the object

17. Select the General tab

18. Enter the Name (e.g. T 1 of 3) and Group Name (e.g. 1) to be used.    Note, the Group Name 
needs to match the Group Name specified in the Group Object

19. Select the Object Styles tab-enter the desired text

20. Create additional Text and Group objects for any additional desired groups (e.g. in the Browser 
demo there are three groups to describe the three products).

21. Create a Bitmap Button Object

22. Open the Bitmap Button properties dialog box

23. Select the General tab

24. Enter the Name (B Next1) and Group Name (e.g. 1) to be used.

25. Select the Fill Styles tab



26. Choose Image as the Fill Style

27. Choose the desired image from the Images listbox (e.g. 'next').    If the image you wish to use is 
not listed, you may import it by clicking the Import Image... button.

28. Choose Resize Frame as the Image Option

29. Select the Object Styles tab

30. Eliminate the caption in the Button Caption edit field

31. Choose Flat as the Appearance option

32. Select the Actions tab-Enter the desired actions. (e.g. see dialog below)

Hint          The buttons used in the CD Browser demo typically perform similar actions.    Using a 
consistent naming scheme allows you to easily create a button that can be duplicated and modified as 
necessary.

33. Create a Bitmap Button Object.

34. Open the Bitmap Button properties dialog box

35. Select the General tab

36. Enter the Name (B    Back1) and Group Name (e.g. 1) to be used. Disable the Enabled property 
in the Initial State groupbox.

37. Select the Fill Styles tab

38. Choose Image as the Fill Style

39. Choose the desired image from the Images listbox (e.g. 'prev_g').    If the image you wish to use is 
not listed, you may import it by clicking the Import Image... button.

40. Choose Resize Frame as the Image Option

41. Select the Object Styles tab

42. Eliminate the caption in the Button Caption edit field

43. Choose Flat as the Appearance option

Note          This button has been created to provide a consistent 'look'.    It does not trigger any actions. 



44. Create additional Next buttons.    You will need one button for each group object.

Note          The last Next button 'B Next3' was been created to provide a consistent 'look'.    It does not 
trigger any actions. 

45. Create additional Back buttons.    The Back buttons will perform actions similar to the following:

See Also

Launch Application/Demo Action



DemoNow Instructions

Live Web Demos

You may use the Windows 95/NT version of DemoShield to create an Internet-enabled demo. Visitors 
to your web site will be able to view your demo live, right from their web browsers. Instead of 
downloading first, and then installing your demo, your web visitors will be able to watch your demo live, 
as each new scene is streamed to their computers. Since any transmission delays are limited to the 
scene transition period, your web demo always looks smooth. 

User Requirements

Your web visitors must be running Windows 95 or NT software. They must be using a web browser that 
supports Plug-Ins or ActiveX controls.    As of this writing, such browsers include Netscape Navigator 
2.0 and later (Plug-Ins only) and Internet Explorer 3.0 and later (both Plug-Ins and ActiveX). 

Netscape Navigator users will first download and install DemoNow, the DemoShield Plug-In. When 
users restart the browser, they will be ready to view any DemoShield web demo. 

If you are using the ActiveX control to play your web demo, Internet Explorer 3.0 users will be able to 
view your web demo immediately, as soon as the page loads. 

You may wish to create two separate web (HTML) pages to allow your web site visitors to choose 
between the ActiveX or Plug-In version.

Step 1:    Prepare Your Demo for the Web

Note          The DemoNow Plug-In and ActiveX Control are subject to updating. Updates to these files 
may require you to update your copy of DemoShield to the latest version.    To be sure of compatibility, 
please download the latest update to DemoShield before creating your Internet demo file. All 
maintenance release updates can be located in the Downloads area on our web site.

Update DemoShield

1. Go to the DemoShield web site (http://www.demoshield.com) and download the latest 
maintenance release for DemoShield (patch file) from our Technical Support area. 

2. Use PKUNZIP to decompress the files.

3. Copy the files to your DemoShield Program folder. 

4. Open your demo as usual in the updated Designer. 

Optimize Your Demo for the Web

In order to support users with slower Internet connections (for example, 14.4 modems), you may wish 
to reduce the size of your demo before putting it on the Web. You will realize the most benefits by 
reducing the size of your graphics files, perhaps by dithering any 256-color images to 16-colors or 
eliminating some graphics in scenes that contain a large number of images. 

Tip          DemoShield supports 16 color palettized bitmaps.    Dithering a 256-color bitmap to 16-color 
palettized bitmap helps to reduce image size while retaining as much of the original quality of the image 
as possible.

We also recommend that you reduce or eliminate any large sound files. You may wish, for example, to 
reduce any WAV files to 11 khz, 8-bit mono or use MIDI files instead.

Keep in mind that DemoShield downloads resources on a scene-by-scene basis.    If you have only a 
few scenes with a great many resources, your web demo viewer will have to wait for each scene to 
load. 

Import Necessary Support Files As Demo Resources

We also recommend that you re-import any resources "imported by reference," so they are saved 
within the demo file. 



Saving these resources within the demo allows DemoShield to compress these files. 

Import ScreenCam Player and ScreenCam Movies

If you are using Lotus ScreenCam Movies (SCM files) in your demo, you will need to    import the 
ScreenCam Player file, SCPLAYER.EXE, as a File Resource in your demo. You should also import any 
SCM files as video resources within your demo. 

Step 2:    Internet Save Your Demo

Note          Demo files saved for the Internet cannot be opened in the Designer.    Always use a different 
file name when saving your demo for the Internet. We recommend that you create a new folder and 
save your Internet demo in that folder.

The following steps explain how to save your demo from the Designer as a series of smaller files that 
can be played live on the Internet. 

These files are: 

╖ A *.DBD file

╖ A *.WID file 

╖ *.SCE files for each scene in your demo

╖ *.RES files for each resource in your demo

1. Choose Internet Save from the File menu. The Internet Save Wizard dialog box appears.

2. Enable Produce initial HTML page if you wish DemoShield to generate a basic HTML page for 
you

3. Browse to choose the desired location to save the files

4. If you have chosen Produce initial HTML page, enter the requested information (i.e., Company 
Name, Product Name, E-mail Address)

5. Click Next

6. If you have chosen Produce initial HTML page, enter the additional requested information (i.e., 
Corporation URL Address, Copyright notice, Product Description, HTML Page Sub-Title)

7. Click Next

8. Click Save

9. Click Next

10. Click Finish

Tip          The last dialog of the Internet Save Wizard displays several important tips for moving your 
demo from where you saved it to the Internet.

The Save for Internet dialog closes, and your original demo file appears in the Designer as if nothing 
happened.

Step 3:    Create HTML Page(s)

When Using the Plug-In you will need to provide an HTML page that will embed the *.WID file.    If you 
chose Produce initial HTML page in the Internet Save Wizard, you already have a starting point.    You 
need only customize this page to match the look and feel of you web site. 

Creating Your Own Page

If you wish to create your own page or to modify an existing one, use the following tag to embed the 
*.WID file in the HTML document that will play the demo. 

<EMBED SRC="DEMONAME.WID" WIDTH=80 HEIGHT=40>
This will display a graphic. Your user will click the graphic to play the demo. If the user is running 



Netscape Navigator or Internet Explorer and does not have the Plug-In installed, he or she will be 
prompted to begin the download process.    After the user downloads and installs the Plug-In, the user 
must restart the browser before viewing the demo. (You may also wish to add some text to your HTML 
page that asks the user to click the button to view the demo.)

For an example of an HTML page containing this <EMBED> tag, enable Produce initial HTML page in 
the first step of the Internet Save Wizard.

Technical Notes on the Plug-In

The *.WID file is a specific MIME type that Netscape Navigator or Internet Explorer will recognize as 
belonging to the DemoShield Plug-In.    Note in Step 4 that you will need to configure your web server 
software to recognize the WID MIME type. 

The *.WID file will be referenced by the Plug-In to locate the DemoShield Player file and all other files 
necessary to play your demo. 

When the DemoShield Plug-In is properly installed, the following will be located in the 
NETSCAPE\PROGRAM\PLUGINS folder: 

 ╖ NPDSHD32.DLL

 ╖ A folder named DPDSHD32, containing this file:    WEBDEMO.EXE

The file WEBDEMO.EXE is an OLE application that handles communication between Netscape and 
DemoShield. 

When Using the ActiveX Control

ActiveX controls, formerly known as OLE controls or OCX controls, are components (or objects) you 
can insert into a web page, or other application, to reuse packaged functionality that someone else 
programmed. You can add ActiveX controls to your web pages by using the standard HTML 
<OBJECT> tag. The object tag includes a set of parameters that you use to specify which data the 
control should use and to control the appearance and behavior of the control. 

The <OBJECT> tag required to call the DemoShield ActiveX Control is provided below. 

<OBJECT CLASSID="clsid:170334c3-f11f-11cf-a857-0000c0d3ac0b" HEIGHT=40 
WIDTH=80 CODEBASE="webdemo.cab#Version=x,x,x,x (where x= the version 
number)">
<PARAM NAME="WID" VALUE="http://www.mycompany.com/demo/mydemo.wid">
</OBJECT>

In the <PARAM NAME> tag, the VALUE is the path where the *.WID file is located on your server. The 
*.WID file is a file that will be produced by the Internet Save process. It will have the same name as 
your web demo.

Note          To view your web demo using ActiveX, your web site visitor must be running Internet Explorer 
3.0 or later. 

Step 4:    Place the appropriate files on your web server

Place the following files in the same program folder on your web server: 

n Your HTML file(s)

n Your *.WID file, *.DBD, *.SCE and *.RES files

n The DemoShield Plug-In files and/or ActiveX Control files

n Any additional required files, including resources imported by reference and support files.

Note          The DemoNow ActiveX and Plug-In files are available from DemoShield Corporation's FTP 
server at the following address:    <ftp://ftp.demoshield.com/DemoShield/PlugIn>

Plug-Ins Only:    Configuring Your Server Software to Recognize the WID MIME Type

You or your ISP will need to make a simple configuration to your server software to recognize the 



DemoShield Plug-In, that is, the WID MIME type. Netscape Plug-Ins require the HTTP server hosting 
the plug-in application to be configured to recognize the Plug-In MIME type. 

Each server software should have a property tab for configuring MIME Types. Use this tab to enter the 
MIME Type "WID" and associate it with the following application: "application/x-DemoShield".    If you 
are unsure how to configure your server consult your systems administrator or ISP.

Alternately, you could place all of the web demo files on an FTP server. With an FTP server, no 
configuration is necessary to recognize the MIME type. This step is not necessary when using only the 
ActiveX Control to play your web demo. 



Which version of ScreenCam should I use with my demo?

To determine which version of ScreenCam to use when recording a ScreenCam Movie (.SCM), you 
must know the operating system you will use to create the movie.    Different operating systems require 
the usage of different versions of ScreenCam while recording. Playback of ScreenCam Movies is 
performed utilizing the same ScreenCam Player, regardless of the platform used. 

Note          DemoShield does not support ScreenCam 97.    This is because ScreenCam 97 will only run 
under 32 bit environments.    ScreenCam 96 runs on both 16 bit and 32 bit environments. 

Windows 3.1

When attempting to record under Windows 3.1, ScreenCam version 2.0 is required.    ScreenCam 2.0 is 
installed by default by the Standard 16 bit DemoShield installation. To install ScreenCam manually, 
launch DS16\SCRNCAM\INSTALL.EXE from the DemoShield CD-ROM. 

Windows 95

When attempting to record under Windows 95, ScreenCam version 2.1 (ScreenCam 96) is required.    
ScreenCam 2.1 is installed by default by the Standard 32 bit DemoShield installation. To install 
ScreenCam manually, launch DS32\SCM96\INSTALL.EXE from the DemoShield CD-ROM. 

Windows NT

Lotus ScreenCam does not support recording under Windows NT.

Tip          To check which version of ScreenCam recorder you are using, launch SCRNCAM.EXE and 
note the splash screen. 

Playing a ScreenCam Movie

Version 2.1 of the ScreenCam Player is used to playback ScreenCam Movies generated under all 
operating systems.    This version of the ScreenCam Player is installed as a standard part of the 
ScreenCam 2.0 and ScreenCam 2.1 installation. 

Tip          To check which version of ScreenCam player you are playing, launch SCPLAYER.EXE and 
note the splash screen.    If the splash screen does not display ScreenCam 96, than you are using the 
wrong ScreenCam player.

See Also

ScreenCam Instructions 

ScreenCam Tips

Creating AVI Recordings



Image Capture Tips

n When capturing images, run Windows in 16-Color mode if possible.    This will keep the file size of 
the image small, as well as ensure that it displays properly on all configurations that will play your 
demo.

n Run Windows at the lowest resolution possible to fit your application (e.g., 640x480).    This is 
especially important for fixed size windowed demos set to 640x480.    Using a small window will 
ensure that the image will fit within the boundaries of the demo playback window as well as the 
viewers screen.

n Plan what you want to capture before you capture it.    This will help you avoid creating several 
captures that are unusable.

n Keep the size of your application constant for all captures.    This will help you avoid problems 
with the image appearing to jump around on the screen as the size of the images changes.

n Capture images at the size you want them to be in the demo.    Resizing images can cause 
significant distortion in a screen capture.    If you must resize the image, use a graphics program 
designed to scale images smoothly such as Paint Shop Pro 4.0 by JASC or Smooth Scaling by 
WexTech.



URL Resource Instructions

URL Resources

DemoShield allows resources to be referenced in a specified URL (e.g., 
ftp://ftp.demoshield.com/DemoShield/).    Essentially, DemoShield will attempt to locate a requested 
resource at the designated URL.    If DemoShield can find the resource, it will be downloaded and used. 
If DemoShield can not find it, the resource embeded in the demo will be used instead.    Possible uses 
for this feature include:

n storing a price list subject to change

n storing contact information

Steps

To specify an Internet URL for a resource you will need to do the following:

1. Open a demo in the Designer

2. Select Resource Manager from the Demo menu

3. Choose the desired resource type

4. Select the resource you wish to provide a URL to

5. Enter the desired URL in the Internet URL edit field

Note          The Internet URL edit field will be grayed out until a resource has been selected from the 
listbox.

6. Click OK

7. Place the URL referenced resource on the specified URL

8. Save the demo and test it through the DemoShield Player

URL Resource Tips

Below are some tips to bear in mind when attempting to utilize this functionality:

n WININET.DLL is required to provide the download.

WININET.DLL is a Microsoft library that provides Internet functionality to Windows programs.    It 
is installed by numerous Internet oriented applications, such as Internet Explorer 3.0.    If 
WININET.DLL is not present, the resource will not be downloaded.    Instead, the one included 
with your demo will be used.

n The DemoShield Player may take longer to launch.

Due to the fact that WININET.DLL, when present, must be initialized prior to its being able to be 
used, the time it takes to launch the Player may be increased.

Resources will be downloaded into the users TEMP directory and removed when the demo is 
terminated.

n A valid URL must be provided in order for DemoShield to obtain the resource.

When a URL is provided in the Resource Manager for a given resource, it must be valid.    
Examples of valid URLs are:

http://www.demoshield.com
ftp://ftp.demoshield.com
Examples of invalid URLs are:

c:/Program Files/Demo
\\FILESERVER\DIR



ftp.demoshield.com
www.demoshield.com

n A resource is downloaded based upon its type.

1. File, Video, and .MID/.RMI Sound resources will be downloaded upon the initialization of the 
DemoShield Player

2. Image and Text resources will be downloaded upon a scene transition.

3. .WAV Sound resources will be downloaded upon demand (i.e., when a Play Sound action calls 
for the requested Sound resource)

n The original filename for the resource will be used to determine if the resource is available on the 
designated URL.

When attempting to determine if a resource is available at the designated URL, DemoShield will 
use the filename of the resource. 

Note This may be different from the name listed in the Resource Manager if the resource was 
renamed after being imported.

n Resources stored on the URL will not be compressed.

Since the resources stored at a URL are not compressed, it is important to keep the size of the 
files small.    Users with slow Internet connections (e.g., 28.8K modem) may experience 
significant delays waiting for resources to download.

n When removing a URL reference, the URL must be removed completely.

If you have added a URL to a resource in the Resource Manager, but change your mind and no 
longer desire to reference the URL, you will need to completely remove the URL provided.    
Otherwise, DemoShield will attempt to locate the resource and there may be a delay in the 
playback of your demo.

n A URL located on a secure server or a proxy server will not work.

DemoShield does not support URLs that reference a proxy server or a secure server.    This 
feature will be added in a future version.

n To access a URL referenced resource, the demo must be previewed through the Player, not the 
Designer.

When test playing your demo, run it through the DemoShield Player to utilize the URL reference. 
When playing the demo through the Designer, the URL will not be utilized.

n A connection to the Internet must be established to download the URL referenced resource.

When the DemoShield Player is initializing, a connection to the Internet will need to be 
established if it does not already exist.    Users using modems to connect to the Internet will be 
presented with a connect dialog prior to the beginning of the demo.    If the user cancels the 
connect, the resources contained in the demo will be used instead of the URL references.

n Set a target platform and test performance.

To ensure that you are satisfied with the performance of a URL referenced resource, I suggest 
that you specify a target platform and test the demo on that platform.    A target platform is a 
machine that you expect the majority of your user base will be using.    For example, if your users 
typically use 28.8K modems, your test machine should use a 28.8K modem to connect to the 
Internet.    Testing performance on a machine that far outpaces your target audience provides 
inaccurate results.



CD Browser Template

Summary

DemoShield includes a template with several predesigned themes for CD Browser demos.    The CD 
Browser Template is designed to allow users of DemoShield to create a professional quality CD 
Browser demo with little effort.    You need only attach the CD Browser template(BROWSER.TPL) and 
enter your information to customize it.    In all, seven different themes are provided.    This document will 
guide you through the steps in using    the Template to create your own CD Browser.

Advantages

n CD Browser demos provide an easy to use front end for users receiving software.

n CD Browser demos allow for cross-marketing opportunity as each demo include a section for 
information about other products in your companies software lineup.

n Contact information for your company is readily available.

Disadvantage

n Users may not wish to view the CD Browser in order to install the product.

Steps

Prior to customizing the Browser, you should have the following information available:

1. Company name

2. Contact information for your company 

3. Product Name

4. Description of other products in your companys product lineup 

5. Directory structure of the CD ROM that will contain the Browser

6. Name of the executable to launch to install your product

To attach a template do the following:

1. Launch the Designer

2. Select New from the File menu

3. Choose One Scene Empty Demo

4. Click Finish

5, Select Attach Template from the File menu

6. Browse for BROWSER.TPL

Note          The default location for Templates under Windows 95/NT is Program 
Files\InstallShield\DemoShield\TEMPLATE.    Under Windows 3.1 the default location is 
ISHIELD\DSHIELD\TEMPLATE

7. Click the Open button

To create a Browser demo using the Template, do the following:

1. Select New Scene from the Scene menu

2. Choose the desired theme from the Scene Layout thumbnails

3. Click OK

To customize the company name, contact information, product name, etc. do the following:



1. Open the properties dialog for the T Company object

2. Select the Object Styles tab

3. Enter your company name

Tip          You can copy and paste text from a text editing program directly into the Object Styles tab of a 
Text Object.

4. Open the properties dialog for the T Contact Info object

5. Select the Object Styles tab

6. Enter information on how to contact your company such as phone, e-mail address, etc.

7. Open the properties dialog for the T Environment object

8. Select the Object Styles tab

9. Enter information on environment for which the application is being deployed (e.g. Windows 95)

Hint          If desired you may create a Text Object to describe the environment if the theme does not 
already contain one.

10. Open the properties dialog for the T Product Info object

11. Select the Object Styles tab

12. Enter a description of other products in your companies product line up or a description of the 
product being installed, as desired

13. Open the properties dialog for the T Product Name object

14. Select the Object Styles tab

15. Enter the name of your product

To customize the descriptions that appear when the mouse is moved over a button do the following:

1. Open the properties dialog for the T Desc1 object

2. Select the Object Styles tab

3. Enter the message you wish to appear when the user has moved the mouse over the Install 
button

4. Open the properties dialog for the T Desc2 object

5. Select the Object Styles tab

6. Enter the message you wish to appear when the user has moved the mouse over the Contact 
Info button

7. Open the properties dialog for the T Desc3 object

8. Select the Object Styles tab

9. Enter the message you wish to appear when the user has moved the mouse over the Product 
Info button

10. Open the properties dialog for the T Desc4 object

11. Select the Object Styles tab

12. Enter the message you wish to appear when the user has moved the mouse over the Exit button

Hint          If you wish to change the label appearing under any of the buttons you may do so in the B 
Optionx objects properties dialog under the Object Styles tab.

To configure the Install button to launch your installation do the following:

1. Open the properties dialog of the B Option1 object



2. Select the Actions tab

3. Double-click the Launch Application action

4. Replace DIRNAME with the directory where you installation is located 

5. Replace SETUP.EXE with the name of the executable that you wish to launch to install your 
product

Hint          Leave the path token in the Application editfield (i.e. <path>) as it is used to let DemoShield 
know that the directory you have provided is relative to the current working directory of the Browser.

Example:

If the structure of your CD ROM were:

<root> 
\app1\setup.exe

You would enter the following in the Launch Application dialog:

<path>app1\setup.exe<path>
This would launch the application SETUP.EXE in the APP1 sub-directory when the B Option1 button 
was clicked.

Tips

n When setting up your CD ROM place the DemoShield Player (DEMO.EXE and DS.DLL for 16 bit 
DemoShield or DEMO32.EXE and DS32.DLL for 16 bit DemoShield) at the root level of the CD 
ROM

n Rename the DemoShield Player to any name desired such as INSTALL.EXE or SETUP.EXE

Warning          The name used for the DemoShield Player and the installation to be launched must be 
unique.    Otherwise pressing the Install button will re-launch the demo instead of launching the 
installation.

n Create an AUTORUN.INF file (see below) to launch the browser automatically when the user 
inserts the CD ROM under Windows 95 or Windows NT 4.0 

n Use the 16 bit DemoShield Player if you are unsure what environment the end-user will be using. 
Since Windows 95/NT supports 16 bit applications you can be sure that users of both 16 bit and 
32 bit environments will be able to use the demo.

n Rename your demo to DEMO.DBD as the DemoShield Player will open a file called DEMO.DBD 
by default when it is launched.

AUTORUN.INF

An AUTORUN.INF file will launch an application when the CD ROM containing it is inserted.    To create 
an AUTORUN.INF do the following

1. Launch a text editor such as Note Pad

2. Enter the following text:

[autorun]
open=name of executable to launch
icon=name of .ico file to use when displaying the CD ROM as a device in the Windows Explorer (optional)

Example:

{autorun}
open=install.exe
icon=install.ico

3. Save the text file using the name AUTORUN.INF

4. Place the file in the root level of your CD ROM



See Also

How Can I Create a Template?



How Can I Create a Template?

A template is a special type of demo file that stores the initial (default) properties for your new objects, 
scenes, and demos.    It has a TPL file extension, and is stored in the TEMPLATES sub-directory (or 
folder).    For example, each time you create a new Text Object, it will start out with the same default 
settings for font, font size, font color, etc.. Those default properties are stored in the TPL file currently 
attached to your demo.    The name of this file appears at the bottom of the Object Palette. 

Template information tells DemoShield, for example, how each new button should look when you first 
place it in the Designer Window: its size, color, and caption.    This file will have a basic layout for the 
demo, which can be used for all different kinds of demos and can be changed according to the purpose 
of the demo.    The basic layout may include all the objects which are always used. 

For scenes, the template concept is even broader.    In addition to storing General Scene Properties 
such as default scene length and scene transition, DemoShield's new templates also store fully 
configured scenes.    Each scene in your template file can be thought of as an individual scene template 
containing not just that scene's General properties, but all of the objects contained in that scene.    You 
may even choose to "link" particular resources to a scene. 

Each time you choose New Scene from the Scene menu, you will open the New Scene dialog box.    
There you will view graphical representations of all the scenes available in the template you are 
currently using.    When you select a particular scene layout, you are actually importing that scene into 
your demo, with all of its objects, scene properties, and referenced resources. (To create a "blank" 
scene, use the Scene Sorter)

Why would you want to edit a template?

Just a few examples:

╖ You want every new Text Object to appear in your demo with a 12 pt. Arial font and a transparent 
background.

╖ You like the basic look of the template for a particular scene--named Menu Scene. You wish to 
use that as the basis for several scenes in your demo,    but you wish to delete several objects--
once, not three or four times.

Steps

To edit your existing template, you would open the appropriate TPL file, make your changes, and save 
the template in your template directory (or folder).

Note          Information in a template affects only those objects, scenes, and demos you create after you 
attach the template, not before.

To change template properties, you need to open the template (*.TPL) file you wish to edit.    Then save 
the file.    To begin using the new template, choose Attach Template from the File menu and attach the 
edited template.    Now, each new object and scene you create will derive its initial properties from the 
latest version of this template file.

To create a new template, perform the following steps:

1. Create a demo with empty scene(s).

2. Save the demo as a Template file.    (e.g., test.tpl)

3. Open up the .TPL file (the file which was just saved).

4. Right click on any objects in the Object Palette and Autoshapes Palette (For example, Bitmap 
button, Text object, Rectangle, Ellipse)

Note          By right clicking on any object, the properties dialog box will be displayed.    Also, with the 
objects, notice the Size tab.    This tab will define the dimensions of how the object should appear.    In 
these properties, there will be no Actions tab or Life tab.



5. Select the Object Styles tab or the Size tab.

6. Make the desired changes.

7. Select the Font tab.

8. Choose the desired font.

9. Select the Font Color tab.

10. Choose the desired font color.

Continue making the desired changes, until all the objects have been changed.    Now lets start making 
changes to the scenes.    Each scene must have a unique name.

Start adding objects to the scene that you need. 

Note          The changes to the objects that were just made will not take effect, until the whole template 
has been saved. 

You can add as many objects that you wish.    To add an image to a scene, perform the following steps:

1. Select Resource Manager from the Demo menu.

2. Select the Images tab.

3. Press the Import button.

4. Browse and select the image to import.

5. Change name of the image so that it includes the scene name also.    For example:    If the image 
name was stars and this image is being imported in Intro scene.    The name of the image will be 
"Intro Stars."

Note          The reason to have the scene name also included for the image is that    DemoShield will 
point to that image every time the scene is loaded.

6. Perform the steps' 2-5 until all the images are imported.

7. Click OK

8. To create a Graphic Object, select the AutoShapes palette from the View menu and you can 
select the desired object.

9. Select the properties of the object.

10. Select the Fill Styles Tab.

11. Choose the image option and select the appropriate image that you would like to import.

12. If there are no images listed, you will have to import an image.

DemoShield uses thumbnails to represent the scenes in the New Scene Dialog.    The dimensions of 
the thumbnails are 130 X 98.    To create the thumbnails for the template that was just created, perform 
the following steps:

Note          For screen captures, Paint Shop Pro version 3.0 by JASC, Inc., was used, and to scale the 
images, Smooth Scaling by WexTech Systems, Inc., was used.    DemoShield has no association with 
JASC, INC and WexTech Systems.    These are the programs that we used here to create thumbnails. 
The thumbnails should only be created after all of the objects in the scene have been included.    When 
trying to use the Template, these thumbnails will be a guide as to how the scene will look.

1. Open up Paint Shop Pro.

2. Select Hot Key from the Capture menu.

3. Select the desired capture keys.

4. Select Object from the Capture menu. 



Note          As soon as the Object option has been selected in Paint Shop Pro, open up DemoShield 
Designer to the scene which will be captured.

5. Press the Hot Key which was selected.

6. If the mouse is moved around, notice the glow around the selection

7. Select the design window and press the left mouse button.

8. The image will be displayed in Paint Shop Pro.

9. Select the ToolBox from the View menu, if    the ToolBox is not selected.

10. Double left click on the Rectangular Selection button.    This button is the third button on the left.

Note          A dialog box will open up after double-clicking on the selection.    To enter the exact 
coordinates, refer to the left corner of Paint Shop Pro, which states the exact coordinates for the height 
and the width.    The coordinates are selected so that only the caption in the design window is not 
selected. 

11. Enter the amount of pixels which should be cut off.    We always use 2 pixels for left, 22 for top 
selections and for right and bottom.    This will depend on the size of the image that was captured.

12. After the coordinates are entered, notice a border will highlight the image.    That is how the image 
will look.    If the image is not highlighted exactly right, then perform steps 10 and 11 again.

13. After the image is highlighted, select Copy from the Edit menu and then select Paste from the 
Edit menu.    Paste the image as a new selection.

Note          The caption will not be part of the new image created.

14. Copy the new image.

15. Launch Smooth Scaling.

16. Select New from the File menu.

17. Select Paste from the Edit menu.

18. Select Resize from the Edit menu.

19. Select the percentage.    Divide by the width of the original image by 130 and round off the 
answer. 

20. After entering the number, notice image will scale down, but it will not be exact.

21. Copy the reduced image and paste it into the Paint Shop Pro.

22. Select Resize from the Image menu.

23. Select Custom Size and enter the exact size.    In this case 130 X 100.

24. Click OK.

Note          The image is exactly 130 X 100. 

25. Select Save from the File menu.

26. Save the image.

Note          The image which was just created will have to be imported or copied directly into the 
DemoShield Designer. 

27. Launch the Designer. 

28. Open the TPL file.

29. Copy the image from the Paint Shop Pro.

30. Paste it in the DemoShield Designer.



31. Choose    Resource Manager from the Demo menu.

32. Select the Images tab.

33. Press the Import button.

34. Import the image which was just saved in Paint Shop Pro.

35. Press the Rename button.

36. Choose the same name for the image as the scene name which it represents..

Perform the above steps until all the scenes have thumbnails.    After the thumbnails have been created 
and all the properties of the objects has been modified to the desired settings, save this file as a .TPL 
file.

To use the template, perform the following steps:

1. Open the desired .DBD file.

2. Select Attach Template from the File menu.

3. Browse and select the template.

Note          The name of the template will be at bottom of the Object palette. 

To view the thumbnails for this template, choose New Scene from the Scene menu.

Notice all the thumbnails for this template.    To create a scene based upon the new template, select 
one of the thumbnails and press OK.    DemoShield will import the selected scene. 

See Also

CD Browser Template



Steps in Creating a Demo

This article is intended to provide you with an idea of the basic process of creating a demo. All of the 
demo projects worked on internally by DemoShield Corporation follow the steps outlined below. If your 
project is of a small scale, some of the steps may not be relevant.    For those of you who have not 
worked on many demo projects, consider these steps a good starting point.    In time you will devise 
your own process.    For those of you who are already experienced developers of demos, consider this 
article as useful in providing some tips that may enhance your process. 

Steps

1. Define the purpose of your demo

In order to create a demo that delivers a powerful message, you must first know its purpose.    Is 
the demo going to explain something to the user?    Is it supposed to make them interested in 
buying your product?    The purpose of your demo will help determine the most appropriate 
content is.

2. Determine who the audience for the demo will be.

The audience for a demo effects how the information should be presented.    If the demo is for the 
banking industry, marble textures and subdued colors would be appropriate.    If the demo will be 
given to graphic artists, attention-grabbing multimedia elements and vibrant colors will help keep 
the viewer interested.

3. Determine the content that will be included in your demo.

The content for your demo will drive the interface appropriate for delivering it.    Content includes 
things such as: marketing copy, graphics, sounds, video, animation, etc..    The most important 
thing to consider at this point is: What    do I require to fulfill the purpose of the demo?    Bells and 
whistles, such as sound effects, can always be added later if you have extra time.

4. Create an outline to determine what topics you wish to cover

Once you know the purpose of your demo and who the audience will be, you should prepare an 
outline of what topics you wish to include in the demo.    You will find that an outline will help 
determine the appropriate interface for relaying the information you wish to convey.

5. Design an interface that is appropriate for the content and topics.

An interface should be suited to the content and topics that the demo will contain.    A simple CD 
Browser demo might have only one scene with a few buttons providing users with access to other 
features within the demo.    On the other hand, an elaborate presales demo covering product 
features, pricing and availability, contact information, and company information would require 
several scenes, including one or more menus to access all of the content.    Remember: the 
interface should fit the content - not the other way around. 

6. Create storyboards for your interface.

A storyboard is a rough sketch of what the interface will look like.    Detail is not important.    Line 
drawings can be used to mark the place of    graphics and solid lines can be drawn to indicate 
sentences of text.    It doesn't take an artist to create a storyboard, so don't worry if you can't draw. 
The purpose of the storyboard is to help you communicate your ideas to others who are working 
on the project with you, as well as to guide you while you are working on the project.

7. Create a flowchart of how one topic relates to another.

A flowchart will serve as your map as you navigate through the course of creating your demo.    
By creating a flowchart, you will uncover some issues you may not have thought of when 
designing your interface, such as: how does the user return from a sub-topic?

8. Create a prototype using placeholders for content that is not yet ready.



A prototype of a demo takes your ideas off of paper and onto the screen.    A prototype will save 
you a lot of grief by giving others a chance to review your ideas before you go through the effort 
of creating the entire demo.    At this point in the project, it is important that the interface and 
layout match the final version.    You should have all topics included with stubs for the sub-topics. 
Any content not yet ready should be indicated with a placeholder.    (A placeholder is a temporary 
filler for content that is not yet ready, e.g., using graphics from a clipart library or scanning in your 
storyboards and displaying the scanned images in place of the actual graphics and text.) .

9. Have the prototype reviewed by management.

When your prototype is complete, have it reviewed by management.    It is much easier to make 
changes when you are beginning to work on your project than when you have already completed 
it.    Although you could show your storyboards to management, a prototype is more effective 
because it can be interacted with.    Someone reviewing your storyboards might make false 
assumptions regarding your interface or layout that would be cleared up by a prototype.

10. Create a written list of tasks to complete for the project.

A list of tasks serves two purposes: deadlines can be defined for those responsible and priorities 
can be set.    Often, simply asking someone to work on something will prove ineffective.    In 
writing them down, you can always review the tasks and see how they are progressing relative to 
the deadline.    It is important to have a clear set of priorities as you may not be able to complete 
all tasks originally planned.    You should be ready with a "minimal" implementation that meets 
your goals and achieves your purpose.    As time permits, you can always add more features from 
the list.

11. Complete your tasks and follow up on others.

Follow-up is often a critical part of task completion.    Others may not remember the tasks that 
they were assigned in your project as a result of other projects that they are working on. A quick 
follow-up call, visit, or e-mail can be the difference between a task being completed on time or a 
task being completely forgotten.

12. Put it all together.

Once all required tasks are complete you can put all the pieces together.    Replace placeholders 
with actual content and finish the project.

13. Quality Assurance

In order to assure that the demo works as intended, it is important to perform quality assurance.    
This is just a fancy way of saying that you need to test the demo.    As many people as possible 
should be asked to use your demo.    It is important that those testing the demo try it on a variety 
of configurations and systems that match as closely as possible your audiences configuration.    
Have users document problems they encounter and specific steps needed to recreate those 
problems.    Correct all problems possible before shipping your demo.

14. Ship it

Congratulations, you've done it!    You have carefully planned, designed, and implemented your 
demo.    By following the steps above, you are much more likely to have delivered a powerful 
coherent message than you would have if your were to have tried the "seat of the pants" 
approach, in which features and content are added haphazardly.



DemoShield Support Programs

DemoShield offers a support plan to meet your needs, whether you are an individual developer or a 
company. DemoShield has made 60 days of free technical support available to the customer with the 
purchase or upgrade of existing DemoShield products. The 60-day period begins on the first day of 
contact with DemoShield Technical Support. After the 60-day offer expires, you may choose between 
the Standard or Priority Technical Support Programs to best suit you support needs in the future.

DemoShield Standard Technical Support Program

All registered users of DemoShield products are entitled to these services on an annual basis.

n Annual subscription cost is $95 per user.

n Support provided by trained DemoShield Developer Support Engineers.

n Unlimited technical support by email and fax only for demo creation assistance and general 
usage questions.

DemoShield Priority Technical Support Program

All registered users of DemoShield products are entitled to these services on an annual basis.

n Annual subscription cost is $195 per user.

n Priority support is available Monday through Friday from 9:30 am to 4:30 pm CST.

n Support provided by trained DemoShield Developer Support Engineers.

n Unlimited technical support by phone, email, or fax for demo created assistance and general 
usage questions.

n All support requests acknowledged within 24 hours.
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Creating an AVI Recording

DemoShield does not have any built-in video screen capturing facilities.    However DemoShield does 
include ScreenCam for creating full screen recordings in the SCM format.    For additional information 
on using ScreenCam see the ScreenCam Instructions article.    If you wish to create screen recordings 
in the AVI format, several third party utilities are available.    This article will describe some of the utilities 
available for each operating system. 

Windows 95/NT

Blue Sky software is currently developing a program called Software Video Camera.    At the time of this 
release Software Video Camera was still in beta testing.    For additional information regarding 
Software Video Camera view the following web page:

http://www.blue-sky.com/products/
Hypercam is a program released by Hyperionics that can record AVIs under Windows 95/NT.    For 
additional information regarding Hypercam view the following web page:

http://www.hyperionics.com/
Windows 95 only

Camcorder is a program released by Microsoft to create full screen AVI recordings.    These recordings 
may include sound in addition to video.    Camcorder may be downloaded from Microsoft.    For 
additional information regarding Camcorder view the following web page:

http://www.microsoft.com/office/office97/camcorder/
Windows/Windows for Workgroups(WfW) 3.1x

ScreenCapture is a utility released by Microsoft for creating AVI recordings under Windows/WfW 3.1x. 

To download Screen Capture from Microsoft do the following:

1. Establish an FTP connection to ftp.microsoft.com

2. Change directories to developr/drg/Multimedia

3. Set type to binary if necessary

Note          If you are using a web browser to download the file, you most likely do not have to worry 
about setting the type to binary. 

4. Download SCRCAP.ZIP

5. Unzip the archive

6. View Screen Capture's on-line help for additional information

See Also
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Editing    AVI Recordings

Many programs are available for editing AVI files.    The program you wish to acquire will depend on 
your needs.    This article will attempt to provide a brief description of several AVI editing utilities 
currently available.    These programs are: Adobe Premiere, Ulead Media Studio, FlickerFree 
Multimedia Products Personal AVI Editor, and Microsofts VidEdit . 

Adobe Premiere

Adobe Premiere sets the standard for video editing programs.    Numerous filters and effects are 
included.    Premiere is typically used by multimedia professionals to create broadcast quality output.    
For the DemoShield user who is interested in creating simple AVIs of screen activity, Premiere probably 
offers more functionality than is necessary.    However, for power users who will be editing digitized 
video, Premiere is an excellent choice.    In addition to Premieres strong video editing capabilities, it is 
also powerful as an audio editing tool.    For information about Adobe Premiere, visit their web page at:

http://www.adobe.com
Ulead Media Studio 

Ulead creates many midrange multimedia utilities.    While not as powerful as Premiere, Media Studio 
does provide all tools needed to edit AVIs of screen activity, digitized video, audio, and images.    Media 
Studio is a good starting point for DemoShield users who intend to create a significant amount of 
multimedia content.    For additional information about Media Studio, visit Uleads web page at:

http://www.ulead.com
FlickerFree Multimedia Products Personal AVI Editor

FlickerFree Multimedia Products Personal AVI Editor is distributed as shareware.    For users who will 
only be performing basic AVI editing of screen activity, Personal AVI Editor may have all that you need 
to get started.    For additional information about Personal AVI Editor, visit Flicker Frees web site at:

http://www.flickerfree.com
Microsofts VidEdit 

Microsofts VidEdit is included as part of the Video for Windows Developers Kit (VfWDK).    The VfWDK 
includes utilities to capture and edit AVI files.    VidEdit is appropriate for DemoShield users who will be 
performing limited AVI editing.

To download the VfWDK from Microsoft do the following:

1. Establish an FTP connection to ftp.microsoft.com

2. Change directories to 

developr/drg/Multimedia/Jumpstart/VfW11e/DK/WINVIDEO
3. Download all of the files in the WINVIDEO directory

4. Run SETUP.EXE to install the downloaded files

5. Consult the on-line help for further information on using the VfWDK utilities

Please note that DemoShield Corporation is in no way affiliated with any of the companies mentioned 
above.    This information is provided to users of DemoShield as a service to our customers.
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AVI Support

DemoShield supports playback of AVI files as Video resources.    For your demo viewers to see the AVI 
files, installing AVI support on their systems may be required.    Whether or not AVI support needs to be 
installed along with your demo depends upon the operating system that you are targeting for your 
demo.

n Windows 95/NT

Under Windows 95/NT, AVI support files are a standard part of the operating system.    Therefore 
there is no need to include AVI support files along with your demo.

n Windows 3.1x and Windows for Workgroups 3.1x

Under Windows 3.1x and Windows for Workgroups (WfW) 3.1x, AVI support files may not be 
present.    Many systems already have AVI support that has been installed with some application 
in the past.    However, you may wish to provide users of Windows/WfW with the means of 
installing AVI support.

Note          AVI files will not play if a user does not have AVI support.

Obtaining AVI Support Files Via CD ROM

The DemoShield CD ROM includes the Video for Windows run-time installation files.    This can be 
used to provide AVI support.    If your demo requires AVI support and will be distributed to users of 
Windows/WfW who may not have AVI support already, follow these steps:

1. Insert the DemoShield CD ROM

2. Change directories to VfW on the CD ROM

3. Copy the contents of the VfW directory on to a floppy disk or your CD ROM

Obtaining AVI Support Files Via Internet FTP

If you do not have access to the DemoShield CD ROM, you may download the Video for Windows run-
time installation files from the Microsoft ftp site.

To download VfW run time from Microsoft do the following:

1. Establish an FTP connection to ftp.microsoft.com

2. Change directories to /softlib/mslfiles/

3. Change the type of download to binary if necessary

Note          If you are using a web browser to download the file, you most likely dont have to worry about 
setting the type to binary. 

4. Download WV1160.EXE

4. Run WV1160.EXE to extract the files contained in the archive 

5. Copy the contents of the WV1160.EXE archive on to a separate floppy or your CD ROM for 
distribution

Note          Do not include the WV1160.EXE file on the floppy.      Only the extracted files should be 
included.

Installing VfW Run Time

You will need to instruct your users who do not have AVI support to install the VfW disk before installing 
your demo.    Failure to install the VfW files will result in AVI files not playing.    To install the VfW files, 
do the following:

1. Insert the VfW floppy



2. Launch SETUP.EXE

3. Follow the steps given by the installation to proceed

Note          The first time an AVI file plays on a system, the display will need to be profiled.    This is a 
process the Microsoft VfW uses to determine the optimum settings for AVI playback.    The profile 
cannot be skipped.
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